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Chapter 24: Expression Tool

Expression Tool 
What it does
With this tool, you can create expression markings—either textual or graphic—that appear in only 
one staff or multiple staves. For example, you might want markings such as arco or Switch to Har-
mon mute to appear in only one staff, or you might want a rehearsal letter or a tempo indication to 
appear in every staff in the score. An expression can be attached to a particular note or rest; if the 
note (or rest) moves, the marking moves with it, although you can drag the marking as far from 
the note (or rest) as you want. An expression can also be attached to a particular measure.

Using the Staff List feature, you can specify which staves you want a given measure expression to 
appear in. Furthermore, you can specify, for each measure expression you place in the score, 
whether you want it to appear in the full score in a particular staff as well as in the part—a mark-
ing can appear in one place without appearing in the other.

Furthermore, expressions can actually affect the playback of the music in the way you’d expect. 
For example, you can program a Forcefully marking to affect the volume level of the music in a 
staff wherever it occurs. For a full discussion of expressions, see EXPRESSIONS.

Special mouse clicks
• Double-click on, above, or below a note or rest that doesn’t have a note expression to dis-

play the Expression Selection dialog box, from which you can select an expression to attach to 
the note or rest you clicked. (If the note or rest is in Voice 2, click below the staff.)

• Double-click above, below, or on any measure that doesn’t contain a measure expression 
to display the Expression Selection dialog box, from which you can select an expression to 
place in the score at the position you clicked.

• Click a note to which an expression has been assigned to display a handle on a note expres-
sion.

• Click a measure in which an expression appears to display a handle on each measure 
expression in the measure.

• Double-click a note whose expressions’ handles are visible to display the Expression Selec-
tion dialog box, from which you can select an additional expression to place in the score, 
attached to the note you clicked.

• Double-click a measure in which expression handles are visible to display the Expression 
Selection dialog box, from which you can select an additional expression to place in the score 
at the position you clicked.

• Click or shift-click expression handles to select one (or additional) expressions, respec-
tively.

• Drag a selected handle to move all selected expressions; press delete, or right mouse click 
the handle and select Delete from the contextual menu to remove them. If you double-click the 
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handle of a Shape Expression, eight bounding handles, or its reshaping handles (for curves 
and single lines) appear, which you can drag to stretch the shape. If you double-click one of 
these handles, or right mouse click the expression handle and select Edit Shape Expression 
Graphically from the contextual menu, the shape’s control handles appear (for single, 
ungrouped shapes), which you can drag to reshape the marking itself. 

• Ctrl-drag a handle if you want to adjust its position without using dynamic drawing (where 
the element is visible at all times while you’re dragging it). The expression will disappear until 
you release the mouse button.

• Double-click or ctrl-double-click an expression handle (or select the handle and press 
enter), or right mouse click the handle and select Edit Text Expression Definition or Edit 
Shape Expression Definition from the contextual menu to display the Text Expression 
Designer dialog box (where you can edit the spelling, playback definition, and font of a Text 
Expression) or the Shape Expression Designer dialog box (where you can adjust the shape or 
playback definition of a Shape Expression).

• Shift–double-click an expression handle, or right mouse click the handle and select Edit 
Expression Assignment from the contextual menu to display the Measure or Note Expres-
sion Assignment dialog box, where you can specify several positioning parameters for the 
expression whose handle you clicked.

Metatools
You can create Expression Metatools—one-key equivalents for expression markings—that can 
save you time if you need to insert many expression markings into your score (because you 
bypass the trip to the Expression Selection dialog box).

To program an Expression Metatool
Click the Expression Tool. Press shift and a letter or number key. Finale displays the Expression 
Selection dialog box; double-click the Expression you want to correspond to the letter or number 
you pressed. Click OK.

To use an Expression Metatool
Click the Expression Tool. While pressing the letter or number key corresponding to the Metatool 
you programmed, click on, above, or below a note or rest. If you have notes in both Voice 1 and 
Voice 2, click above the staff for Voice 1 or below for Voice 2 to place the articulation. The expres-
sion appears at the place you clicked.

Important note: If you use a Metatool to place a Shape Expression into the score, you create a 
duplicate of that shape. This gives you an important advantage when you’re placing several of the 
same Shape Expression into a score, because it means that you can reshape or resize each copy 
individually. If you didn’t use a Metatool to place Shape Expressions into the score—and placed 
them instead by selecting them from the selection box directly—you would reshape every occur-
rence of a shape when you adjusted any one of them.

Contextual menus
Contextual menus are reached by right mouse-clicking on the handle of an object. A contextual 
menu will be displayed where you can select various items. They will also state whether the 
expression is attached to a note or a measure.
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Expression Menu
How to get there

Click the Expression Tool y.

What it does
The Expression Menu allow you to show expression handles and provides direction for metatools.

• Show All Handles. Choose this item to show all the expression handles on the page.

• Show Measure/Note handles. Choose this item to show only measure expression handles or 
note expression handles on the measure or note you clicked.

• Metatools: Measure-attached • Metatools: Note-attached • Metatools: Context-Sensitive. 
Choose one of these items to determine where expressions placed with metatools will be 
placed. Context-Sensitive will use the position in the score where you clicked to determine 
whether the expression is attached to the note or the measure.

Text Expression handles

Menu item What it does

Edit Expression Assignment Display the Expression Assignment dialog box

Edit Text Expression Definition Display the Text Expression Designer dialog box

Edit Font Display the Font dialog box

Delete Removes selected expressions

Shape Expression handles

Menu item What it does

Edit Expression Assignment Display the Expression Assignment dialog box

Edit Shape Expression Definition Display the Shape Expression Designer dialog box

Edit Shape Expression Graphically Displays bounding box handles for graphically editing the shape 
expression

Delete Removes selected expressions
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Expression Selection dialog box
How to get there

Click the Expression Tool y, and double-click a note or measure. (If the note already has an 

expression attached, click again.) This dialog box also appears when you’re programming an 
expression Metatool: While pressing shift, press a letter or number key.

What it does
This dialog box displays a palette of any Expressions (either text- or shape-based) you’ve created 
in, or loaded into, your document. If your Maestro Font Default file is in place, this dialog box dis-
plays a selection of common Text Expressions, such as Allegro, ritard, and various dynamic mark-
ings. When you click the Shape button (below the list box), you see a palette of Shape 
Expressions, such as slurs and crescendos.
From this dialog box, you can select an expression to put in the score, edit an existing one, or cre-
ate a new one. The number in the top left corner of each item lists the slot number for the item. 
This can be handy if you have the option of typing in the slot number in a dialog box instead of 
scrolling through the selection dialog box. Occasionally, a character in parenthesis appears in the 
top right corner of an item in the selection dialog box. This character indicates the Metatool 
assigned to the item.
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• Edit. After clicking an existing expression, click Edit to enter the Text Expression or Shape 
Expression Designer dialog box (depending on whether the Text or Shape radio button is 
selected), where you can edit it. Remember that you’re simultaneously editing every occur-
rence of the expression in the score.

• Create. Click Create if you want to create your own expression. You proceed to the Text 
Expression or Shape Expression Designer dialog box (depending on whether the Text or 
Shape radio button is selected), where you can create a new expression.  You can select more 
than one item. See TEXT EXPRESSION DESIGNER DIALOG BOX and SHAPE EXPRESSION 
DESIGNER DIALOG BOX for more information.

• Duplicate. Click Duplicate to make a duplicate copy of the highlighted expression. You can 
select more than one item. Use Shift-click to select an additional item and include all the items 
in between. Use ctrl-click to select only a specific additional item in the list.
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• Delete. After clicking an existing expression, click Delete to remove the expression from the 
palette. You can select more than one item. Use Shift-click to select an additional item and 
include all the items in between. Use ctrl-click to select only a specific additional item in the 
list. If the expression is used in the score, the Delete Element dialog box is displayed, where 
you can specify delete options. See DELETE ELEMENT DIALOG BOX.

• Move Up • Move Down. Click these buttons to move the selected item or items up or down in 
the list. You can select more than one item. Use Shift-click to select an additional item and 
include all the items in between. Use ctrl-click to select only a specific additional item in the 
list.

• Text. If this button is selected, the selection box displays a list of Text Expressions—expres-
sion markings consisting solely of text characters. (Dynamics and certain musical symbols 
can also be considered text, even though they belong to the Maestro music font, or another 
music font.)

• Shape. If this button is selected, the selection box displays a palette of Shape Expressions—
expression markings consisting of lines and shapes you’ve created in the Shape Designer.
Important note: The functions of Shape Expressions such as phrase markings, slurs, and cre-
scendos can be duplicated much more easily through the use of Smart Shapes. If you place a 
Shape Expression in more than one place in the score, be aware that editing it will change 
every occurrence of it in the score—a particularly unfortunate situation if, for example, you’ve 
carefully changed the shape of each slur to fit its particular notes. For a more complete discus-
sion, see SLURS and CRESCENDO/DECRESCENDO.

• Measure Expression • Note Expression. Use these radio buttons to determine if your expres-
sion should be attached to a note or a measure. If, when you clicked on the score, you were not 
near a note, that option is disabled and your expression will be attached to the nearest mea-
sure.

• Cancel. Click Cancel to return to the score without adding an expression.
• Select. After clicking a Text Expression or Shape Expression in the selection box (and chang-

ing the setting for note expression or measure expression), click Select to tell Finale you want 
to place it in the score. You proceed to the Expression Assignment dialog box (where you have 
some additional positioning options), and from there you return to the score.
Note that you can simply double-click the desired expression instead of clicking it and click-
ing Select.

Note Expression Assignment dialog box
How to get there

Click the Expression Tool y, and double-click on, above, or below a note. Select Note Expres-

sion in the Expression Selection dialog box. Double-click an existing expression from the selec-
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tion box (or create one by clicking Create). If a marking is already in the score, you can also reach 
this dialog box by shift-double-clicking its handle.

What it does
After you’ve selected a note expression to place in the score, Finale displays this dialog box, 
offering you several additional options pertaining to the marking’s placement and playback defini-
tion.

• Distance from Top Note • Bottom Note • H: • V:. These controls let you specify the precise 
vertical and horizontal position of the expression mark. If you’re attaching this expression to a 
chord, first decide whether you want it “fastened” to the top or bottom of the chord, by choos-
ing Top Note or Bottom Note from the drop-down list.

Next, specify the marking’s distance from that note by entering values in the H: (horizontal) 
and V: (vertical) number boxes. (A higher number moves the marking to the right or upward.) 
Of course, you can also simply drag the marking’s handle when you return to the score.

• On Playback, Affect: Current Layer • Layer 1 • Layer 2 • Layer 3 • Layer 4 • Chord • 
Dynamic Layer. The essential function of these drop-down list choices is to let you specify 
which of these musical elements you want affected by a marking’s playback definition. For 
example, it’s possible to specify that a dynamic marking affect only the chord symbol above 
the music to which it’s attached, or to attach a patch change to only one of Finale’s four layers.

If you leave Current Layer selected, the expression you’re assigning will affect the layer of the 
note it’s attached to.

• Begin Playback at Assigned Note • Position in Measure. If the expression you’re placing 
has been defined for playback, you can control where its playback effect will “kick in.” When 
Assigned Note is selected, you’ll hear its effect beginning with the note to which you attached 
it. When Position in Measure is selected, you won’t hear the marking’s effect until Finale 
reaches the marking itself while playing back, no matter where it falls (even if it’s in a differ-
ent measure). 
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• OK • Cancel. Click OK (or press enter) to confirm your settings and return to the score, where 
you’ll see the expression marking. Click Cancel to return to the score without adding or edit-
ing an expression marking.

Measure Expression Assignment dialog box
How to get there

Click the Expression Tool y, and double-click a measure. Select Measure Expression in the 

Expression Selection dialog box. Double-click an existing expression from the selection box, 
click an expression in the list and click select, or create one by clicking Create.

If a marking is already in the score, you can also reach the Measure Expression Assignment dialog 
box by shift–double-clicking its handle.

What it does
After you’ve selected a measure expression (any expression marking you want to appear in one or 
more staves or a list of staves), Finale displays this dialog box, offering you several additional 
options pertaining to the marking’s placement and playback. One of the most important options is 
the Staff List feature, which lets you specify in which staves you want the marking to appear (in 
the full score), as well as in which extracted parts it should appear.
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• Distance from Beginning of Measure • H: • V:. The numbers in these text boxes let you spec-
ify the precise vertical and horizontal distance between the expression you’re placing and the 
upper-left corner of the measure you clicked (not counting any meter or key signature). A 
higher number moves the marking to the right or upward. Of course, you can also simply drag 
the marking’s handle when you return to the score.

• Beats • EDUs • [Current measurement unit]. Note that Finale measures the marking’s hori-
zontal position in musical distance—that is, according to its rhythmic position in the measure. 
(If you later make the measure wider or narrower, the marking will remain proportionately in 
the right place.) Use the drop-down list beside the H: text box to choose the units of rhythmic 
measurement: beats or EDUs (1024ths of a quarter note). This drop-down list also includes the 
current Measurement Units (Options Menu), which is used only in cases where you position 
the expression before the measure that the expression is attached to.

• Show On: All Staves • This Staff Only. Select All Staves to show the expression on every 
staff in the score and parts. All Staves is selected by default. Select This Staff Only to assign 
the expression to the current staff only. Use the This Staff Only option if you want an expres-
sion to appear only in the current staff.

• Staff List: New Staff List • (All defined Staff Lists); Edit. Select New Staff List to display 
the Staff List dialog box, where you define which staves will display expressions. To select a 
Staff List already created for use in the score, choose its name from the drop-down list. Click 
Edit to display the Staff List dialog box for the selected Staff List, and change which staves 
the expression using that Staff List should appear in.

• Begin Playback at Beginning of Measure • Position in Measure. If the expression you’re placing 
has been defined for playback, you can control where its playback effect will “kick in.” When Begin-
ning of Measure is selected, you’ll hear its effect at the beginning of the measure, even if the mark-
ing itself appears in the middle of the measure. When Position in Measure is selected, you won’t 
hear the marking’s effect until Finale reaches the marking itself while playing back, no matter where 
it falls (even if it’s in the previous or next measure); Position in Measure, therefore, is a good choice 
for dynamic markings.

• Allow Individual Positioning. Normally, when you place a measure expression marking in 
the score, it appears in exactly the same position in every staff. When you drag any marking, 
the markings in all staves move simultaneously. Select this checkbox, however, if you want 
this marking to be independently movable in every staff. (To restore the marking to its 
“linked-together” mode, shift–double-click its handle in the score, and turn Allow Individual 
Positioning off.)

• OK • Cancel. Click OK (or press enter) to confirm your settings and return to the score, where 
you’ll see the expression mark. Click Cancel to return to the score without adding or editing 
an expression mark.



Staff List dialog box 24-10      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

Staff List dialog box
How to get there

Click the Expression Tool y. Double-click a measure. Select Measure Expression in the 

Expression Selection dialog box. Double-click an expression in the Expression Selection dialog 
box, or click an expression in the list and click Select. The Measure Expression Assignment dia-
log box appears. Click Staff List, then choose New Staff List from the Staff List drop-down list, or 
select an existing Staff List from the drop-down list, and click Edit.

If an expression is already in the score, shift-double-click its handle to display the Measure 
Expression Assignment dialog box. Click Staff List, then choose New Staff List, or select an 
existing Staff List from the Staff List drop-down list, then click Edit.

What it does
The Staff List dialog box provides control over creating and editing Staff Lists, which are used for 
showing measure expressions. You can name each Staff List that appears in the drop-down list and 
cycle through every Staff List in your score using the arrow controls or by choosing a Staff List 
name from the drop-down list. Staff Lists can be added or removed with the click of a button. You 
can also force Finale to always show a measure expression, overriding settings in the Staff 
Attributes dialog box.
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• Staff List. Choose the Staff List you want to edit from the drop-down list, or click the up or 
down arrow control to cycle through the Staff List names. Information about the currently 
selected Staff List appears in the dialog box.

• List Name. The name of the currently selected Staff List appears here. If you’re adding a new 
Staff List, change the name that appears in the text box, then click Add. The names of the Staff 
Lists appear in alphabetical order.

• Add • Delete. Click Add to add a new Staff List after you’ve entered the name of the new list. 
The new list will be added to the drop-down list in alphabetical order. You can create over 
1000 staff lists (1023 to be exact). Click Delete to remove the currently selected Staff List. 
Finale removes the Staff List from the drop-down list.

• Staves • Score • Parts. The name of each staff in the score appears in the Staves column. 
Entries in the Score and Parts columns for each staff indicate whether measure expressions for 
the staff should appear. Click in the Score or Parts column to set the Score and Parts entries for 
a staff. The Score and Parts columns cycle between three states as you click: hide an expres-
sion for the staff (the column is blank), show an expression (an “X” appears in the column), or 
force an expression to always appear (an “F” appears in the column). When an “F” appears, 
the expression will always appear in that staff, even if you’ve elected to hide expressions for 
the staff in the Staff Attributes dialog box.

• Set Score • Clear Score • Set Parts • Clear Parts. Use these buttons to control all the settings 
in the Score or Parts columns at once. Click Clear Score (or Clear Parts) to remove “X” or “F” 
from every staff in the Score or Parts column. Click Set Score (or Set Parts) to add an “X” to 
every staff in the Score or Parts column.

• Always Show On: Top Score Staff • Top Part Staff • Bottom Score Staff • Bottom Part 
Staff. If you’ve optimized your score so that all blank staves are hidden, but you want an 
expression (such as a rehearsal letter) to always appear at the top of the score above the top 
staff, the expression normally won’t be shown if the top staff was removed from a staff system 
by the optimizing process. Select Top (or Bottom) Score Staff to tell Finale to always show a 
measure expression on the top (or bottom) staff of each system, regardless of which staff hap-
pens to be at the top (or bottom) of the system.

Note: You can also make a measure expression always appear in the top or bottom staff for a 
part. This is a useful feature if you want to extract several staves from your score into a single 
“part” and then optimize the extracted part. Click Top (or Bottom) Part Staff to display a mea-
sure expression in the top or bottom staff of every system of the extracted part.

• OK • Cancel. Click Cancel to return to the Measure Expression Assignment dialog box with-
out choosing any Staff List for the expression you’re adding or editing. Click OK (or press 
enter) to confirm your selection of a Staff List for the expression you’re adding or editing.
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Text Expression Designer dialog box
How to get there

Click the Expression Tool y, and double-click a note or measure. (If you want to edit a text 

expression that’s already in the score, double-click or ctrl-double-click its handle.) Click Create, 
or click a text expression and then click Edit.

What it does
There are two kinds of Expressions: Text Expressions, composed of words or symbols you can 
type (Allegro, ritard, dynamic markings, and so on), and Shape Expressions, composed of shapes 
you’ve created in the Shape Designer. Either can be defined for playback.

In this dialog box, you can create a new Text Expression or edit an existing one, including correct-
ing its spelling or setting its font. If you click Playback Options, the dialog box expands to show 
you the playback definitions to which you can assign your Text Expression. 

 

• [Text box]. This text box is where you type the expression text itself, which appears in the 
system font regardless of the actual font you’ve chosen. For example, if you’re using the Mae-
stro font to create an F symbol, you’ll see a capital F in this box.

You can incorporate the number sign (#, or shift–3) into the text for your expression; it acts as 
a stand-in for data that may change, depending on the situation. When the Text Expression 
appears in the score, Finale will substitute a number for the number sign, depending on the 
Replace ‘#’ Sign option you’ve selected.

• Set Font. Click this button to display the Font dialog box, where you can specify a font for the 
text expression. Once again, the expression will appear in the system font in the Text Expres-
sion Designer; only when you return to the Expression Selection dialog box (or to the score 
itself) will you see the expression displayed in the font you chose.

• Playback Options. Click this button to make the dialog box expand. Additional options 
appear, governing this expression’s effect on playback. If your score isn’t intended for MIDI 
playback, you need never click this button or know what it conceals.
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• Enclose Expression. If you want your expression framed by a geometric enclosure, click this 
box to display the Enclosure Designer dialog box, where you can specify the shape, size, and 
line thickness of the enclosure. (See ENCLOSURE DESIGNER DIALOG BOX for more informa-
tion.)

You might use this feature, for example, when creating rehearsal letters—you can enclose 
each letter in a neat rectangle.

• Do Not Print Text in <Angle Brackets>. Select this checkbox to prevent text enclosed by 
angle brackets, such as <cellos only>, from printing.

• Break Multimeasure Rest. Select this checkbox to force a multimeasure rest to break where 
this expression is placed, such as for a rehearsal number.

• Replace ‘#’ with: Set-to-Value Number • Controller Number • Pass Number. To use the 
number sign variable, make sure the Replace ‘#’ With checkbox is selected. Select the top 
radio button if you want the number sign to be replaced by the number in the Set To Value box 
(see Set to Value).

For example, in the Text box you could type “Allegro (MM = #).” If you then define this mark-
ing to have a tempo-controlling playback definition with a value of 144 (that is, 144 quarter 
notes per minute), the marking will appear in the score as “Allegro (MM = 144).” (You’d cre-
ate this playback effect by clicking Playback Options, choosing Tempo from the drop-down 
list, and entering 144 in the Set To Value text box.)
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Click the Controller Number radio button if you want the number sign to be replaced by the 
number in the Controller box (in the expanded dialog box). For example, you could type “Use 
MIDI controller #” in the Text box. If you then define the playback of this expression to acti-
vate controller 64 (by choosing Controller from the Type drop-down list and entering 64 in the 
Controller text box), the expression will say “Use MIDI controller 64” when it appears in the 
score.

Finally, click Pass Number if you want the number sign to be replaced by the number in the 
Play Only on Pass ___  text box (in the expanded dialog box). Because the number in the Play 
Only on Pass ___  text box identifies the repetition during which this marking should affect 
playback, you could type “#th Time Only” in the Text box. If you then define the playback of 
this expression to affect the playback only on pass number 4 (that is, the fourth time the music 
is repeated), the expression will say “4th Time Only” when it appears in the score.

• OK • Cancel. Click OK (or press enter) to return to the Expression Selection dialog box, 
where your new (or edited) text expression appears in the list (in the font you’ve specified)—
or to return to the score. Note that when you edit an expression, your editing will affect every 
occurrence of the marking in the score. Click Cancel to return to the Expression Selection dia-
log box (or to the score) without creating or editing a text expression.

• Type:. From this drop-down list, choose the playback effect you want this Text Expression to 
have on MIDI playback. Each option is described separately below.

• Type:None. This choice, the default, means that your Text Expression will have no effect on 
playback.

• Type:Tempo. Select this option if you want the marking you’re creating to affect the playback 
tempo wherever it appears in the score. When Tempo is selected, a new drop-down list 
appears, from which you can choose the rhythmic pulse for the Tempo setting (quarter notes 
per minute, half notes, etc.); specify the number of these units per minute in the Set to Value 
text box. See Set to Value.

If the tempo is to change gradually (a rallentando or accelerando), don’t enter any value in the 
Set To Value box. Instead, use an Executable Shape (see Execute Shape). (For a complete dis-
cussion of the use of Executable Shapes to create tempo changes, see RALLENTANDO.)

• Type:Controller. MIDI controllers include modulation wheels, breath controllers, pedals, and 
so on (the pitch wheel has a separate Playback Definition option; see Pitchwheel, below). 
When Controller is selected, a new text box appears with a drop-down list, in which you can 
specify the MIDI controller itself by entering its number; for example, the controller number 
for the sustain pedal (on most keyboards) is 64.

Some common controllers (see the Appendix section MORE ON MIDI for a complete list):

Controller 
number

Controller
Controller 

number
Controller

Controller 
number

Controller

1 Modulation wheel or lever 7 Main volume 65 Portamento

2 Breath Controller 10 Pan 66 Sostenuto

4 Foot Controller 64 Sustain pedal 67 Soft Pedal
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If you select this option, the number in the Set To Value box (or the shape identified by the 
number in the Execute Shape box) governs the effect of this controller.

• Type:Key Velocity. Choose Key Velocity if you want the marking you’re creating to affect the 
key velocity (how hard the keys are struck) wherever it appears in the score. (Use this option 
to define dynamic markings, for example.) Specify the velocity value itself in the Set to Value 
text box; the scale of MIDI velocity values is from zero (silence) to 127 (very loud). See Set to 
Value.

If the volume is to change gradually (a crescendo or diminuendo), don’t enter a value in the 
Set To Value box. Instead, use an Executable Shape (see Execute Shape, below). (There are 
also quicker and easier ways to create a playback crescendo, however, using the MIDI Tool. 
For a complete discussion of all three kinds of crescendos, see CRESCENDO/DECRESCENDO.)

• Type:Transposition. Choose Transposition if you want the marking you’re creating to affect 
the transposition of the music wherever it appears in the score. (Use this option to define an 
8va marking, for example—but don’t forget to create another expression at the end of the 
affected passage to “cancel out” the transposition. See 8VA/8VB.) Specify the transposition 
value itself, expressed as a positive or negative number of half steps, in the Set to Value text 
box.See Set to Value.

If, for a special effect, the transposition is supposed to change gradually as the music plays, 
don’t enter any value in the Set To Value box. Instead, use an Executable Shape (see Execute 
Shape, below). For a complete discussion of Executable Shapes, see EXPRESSIONS—To define 
an expression for playback. For specific uses of the Transposition playback option, see also 
TRILLS.

Note that for any use of the Transposition playback effect, Finale only changes the playback 
transposition of the affected notes. No note transpositions appear on the screen or in printouts.

• Type:Channel. Choose this option if you want the marking you’re creating to effect a MIDI 
channel change wherever it appears in a staff. In the Set to Value text box, specify the MIDI 
channel you want the marking to switch the playback to. See Set to Value.

• Type:Patch. Select this option if you want the expression you’re defining to change the MIDI 
keyboard patch or voice being played by the staff in which it appears. Select the instrument 
you would like to hear from the GM (General MIDI) drop down list. This will automatically 
set up the Bank Select and Program Change settings. See PATCHES for more information.

• Type:Pitchwheel. Select this option if you want the marking you’re creating, wherever it 
appears in the score, to change the setting of the pitch bend wheel in playback. You can also 
specify a new value by entering a number in the Set to Value text box.  (See Set to Value.)To 
create a true pitch bend effect, however, click Execute Shape, then Select, and choose (or cre-
ate) the shape whose contour you want to govern the pitch bend. (For a complete discussion of 
pitch bends, see PITCH WHEEL.)

• Type:Channel Pressure. Choose Channel Pressure if you want the expression you’re defin-
ing to govern the monophonic aftertouch (channel pressure) setting of the affected notes. 
(Aftertouch or channel pressure is the pressure you apply to a key while it’s being held down.) 
If you select this and enter a number in the Set To Value text box, you can define an expression 
that sets the aftertouch setting to a particular value (on a scale from 0 [no pressure] to 127 
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[maximum pressure]). You might use an expression with a Channel Pressure playback defini-
tion, for example, to trigger a vibrato effect (if your synthesizer is programmed to interpret 
aftertouch in this way).

You might also want to use the Channel Pressure parameter in conjunction with an Executable 
Shape. Click Execute Shape, then Select, and choose (or create) the shape whose contour you 
want to govern the application of key pressure.

• Type:Restrike Keys. Select this option if you want Finale to play the notes affected by this 
marking over and over again (for tremolo or trill effects, for example). The Set To Value box is 
not used for this effect; instead, click Execute Shape and Select to choose—or create—the shape 
that’s to govern the rapidity and duration of the restriking. For an example of the use of this 
option, see TRILLS.

• Type:Dump. Click Dump to display the Playback Data Dump dialog box. In this dialog box, 
you can create a playback instruction for Finale to send the staff’s playback information over 
more than a single MIDI channel. If you’re a MIDI programmer, you can also use this option 
to generate System Exclusive data or sequencer Start signals; see PLAYBACK DATA DUMP 
DIALOG BOX.

• Type:Play Tempo Tool Changes • Ignore Tempo Tool Changes. If you’ve made tempo 
changes using the Tempo Tool or captured tempo information from a performance in the Tran-
scription Mode of HyperScribe, you can make Finale “obey” this invisible tempo information 
in some passages and ignore it in others. (In passages where you’ve told Finale not to use this 
stored tempo information, it will use the default tempo you’ve set in the Playback Controls, or 
it will adhere to any Tempo-defined expressions you’ve placed into the score.)

At the beginning of the passage where you want Finale to obey the tempo information, create 
an expression whose playback has been defined with the Play Tempo Tool Changes setting. At 
the end of the passage, create a second expression, but define its playback to be Ignore Tempo 
Tool Changes.

The Play Tempo Tool Changes setting also allows Tempo Tool adjustments to be saved to a 
MIDI file.

• Type: Swing; Standard Swing Values. Select Swing if you want Finale to play the notes 
affected by this marking with a slight delay on the second note of a triplet, or with a swing 
feel. Select a Swing value from the drop-down list to select a pre-defined amount of swing. Or, 
type into the box the percentage of swing - zero is no swing, 100% is standard.
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• Set to Value. The number in this text box specifies the MIDI value of the playback parameter 
you’ve selected from the Type drop-down list (see below; not all of the playback parameters 
require a value in the Set To Value box). The units depend on the parameter you’ve selected, as 
shown in this table.

• Execute Shape • Select. While some playback effects take place instantaneously (a tempo or 
volume change, for example), others occur over time—a ritard, for example, or a crescendo.

To create playback definitions of this latter type, you can assign a Text Expression to an Exe-
cutable Shape—in essence, a graph whose contours Finale “reads” as it plays back the music. 
For a complete discussion of how Executable Shapes affect playback, see EXPRESSIONS—To 
define an expression for playback.

The number in this text box identifies the Executable Shape you’ve chosen to represent the 
playback effect of the marking you’re defining. To view the available shapes, click Select; the 
Executable Shape Selection box appears, where you can double-click the desired shape. (Or, if 
the shape you want doesn’t appear in the selection box, create your own by clicking Create, 
Select, and Create to enter the Shape Designer. For instructions on the use of the Shape 
Designer, see SHAPE DESIGNER.)

• Play Only on Pass ___. If Finale encounters the expression whose playback you’re defining 
more than once—in other words, if it falls within a repeated section you’ve created using the 
Repeat Tool—the number in this text box specifies which time through the expression will 
have a playback effect. (If you leave the number at its default value, zero, the marking will 
affect playback on every repeat.)

For example, if you’ve created an expression such as “ritard 2nd time only” by entering a 2 
into this box, Finale will apply the playback definition you’ve defined only on the second time 
it plays back the affected passage.

Shape Expression Designer dialog box
How to get there
If a shape expression has already been entered in your score, you can access this dialog box by 

selecting the Expression Tool y and ctrl-double-clicking the expression's handle.

Drop-down 
list choice 

Set to Value units
Drop-down list 

choice 
Set to Value units

Tempo Beats per minute Channel MIDI channel (1 to 16 [or 17–32, if 
you’re using both ports])

Controller 0 (off) or 127 (on) for pedals; any 
value from 0 to 127 for variable con-
trollers (such as a modulation wheel)

Patch Synthesizer patch number (1 to 128)

Key Velocity MIDI key velocity (0 to 127) Pitchwheel Pitch wheel position (-8192 to 8191; 0 is 
“at rest” position)

Transposition Half steps (positive or negative) Channel Pressure Channel Pressure (0 to 127)
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Otherwise, select the Expression Tool, and double-click on a note or in a measure. Click Shape. 
Click on any of the Shape Expressions displayed, then click the edit button. If no expressions are 
displayed, you'll need to create a shape expression first (see SHAPE DESIGNER). 

What it does
A Shape Expression is a graphic expression mark, such as a slur, crescendo, or glissando. You 
draw the basic shape in the Shape Designer (see SHAPE DESIGNER). In this dialog box you can 
define a playback effect for a shape; the box also gives you access to the Shape Designer, so that 
you can edit the shape itself.

It’s important to understand, however, that if you use this dialog box to edit a Shape Expression 
you’ve already placed in the score, you make every occurrence of that shape in the score snap 
back to its original shape and size, even if you have carefully stretched and reshaped each after 
placing it into the score.

• Shape • Select. The number in the text box identifies the raw shape you’re editing. If there’s a 
zero in this box, click Select to display the Shape Selection dialog box, where you can double-
click an existing shape (or click Create to enter the Shape Designer, where you can create your 
own). In either case, when you return to the Shape Expression Designer, Finale enters the 
number of the shape you selected in the text box.

• Edit. If there’s a number in the Shape text box, click Edit to enter the Shape Designer, where 
you can make changes to the shape.
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• Playback Options. When you click this button, the dialog box expands to reveal several 
options that govern this Shape Expression’s playback effect.

• Allow Horizontal Stretching. When Finale creates the image of a page of your score in Page 
View, it tends to stretch each measure by a small amount in order to justify each system neatly 
to the page margins. In many cases you’ll want any Shape Expressions (such as slurs, cre-
scendo hairpins, and glissandi) to stretch along with the measures in which they occur. In such 
cases, select this item.

Deselect this checkbox if you don’t want to permit a shape to be stretched horizontally—for 
example, you might prefer that a harp pedaling diagram retain its original dimensions. 

• Display On Screen Only (Do Not Print). Select this checkbox to prevent the shape expres-
sion from printing.

• Break Multimeasure Rest. Select this checkbox to force a multimeasure rest to break when 
this expression is placed.

• OK • Cancel. Click OK (or press enter) to confirm your settings and exit this dialog box. If 
you’ve just created a new Shape Expression, it appears in the selection box. Click Cancel to 
return to the Expression Selection dialog box without creating or modifying a Shape Expres-
sion.

• Type: • Effect: Set to Value • Execute Shape; Select • Play Only on Pass. These items, visi-
ble only after you click Playback Options, list and describe the various playback effects your 
Shape Expression can have. These playback options for a Shape Expression are precisely the 
same as the options for a Text Expression. For a complete description, see TEXT EXPRESSION 
DESIGNER DIALOG BOX.
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Playback Data Dump dialog box
How to get there

Click the Expression Tool y, and double-click a note or measure. Click Create (or click an 

existing marking and click Edit). Click Playback Options to expand the dialog box; choose Dump 
from the Type drop-down list.

If the expression is already in the score, double-click its handle; click Playback Options; from the 
Type drop-down list, choose Dump.

What it does
This option requires an in-depth understanding of the MIDI protocol. For instructions in practical 
uses of this dialog box, see MIDI —To assign a staff to more than one MIDI channel. For more 
information on MIDI in general, see the APPENDIX - MORE ON MIDI.

This dialog box offers several data-dump functions, one of these is its ability to enable multiple 
MIDI channels for the staff in which it appears. You can also use it to transmit System Exclusive 
MIDI data or a sequencer Start message.

• Number of Units. The number in this text box tells Finale how long the MIDI message trans-
mitted by the expression will be, in bytes.

If you’re creating an expression whose function is to send a staff’s music over additional MIDI 
channels, enter 2 or 3 (depending on whether you want the staff’s playback routed to 1 or 2 
additional MIDI channels). A staff can play up to three MIDI channels, including the primary 
MIDI channel you’ve established for the staff.

• Data. Enter the codes you want Finale to transmit when it plays back the expression you’re 
defining for playback. If you prefer, you can enter standard (decimal) notation directly into 
these boxes (but delete the “$00” first); Finale will automatically convert each number into 
hexadecimal MIDI notation.

If you’re creating a note expression that tells Finale to begin sending a staff’s output to addi-
tional MIDI channels, enter $FF in the first of these three text boxes. In the next boxes, enter 
one or two numbers, corresponding to the MIDI channels you want the staff’s playback routed 
to minus one. In other words, if you want the staff to play over channels 5 and 6 (in addition to 
its primary MIDI channel), enter 4 in the second Data box and 5 in the third, because you need 
to subtract one from each MIDI channel number.
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Technical note: Here are some other codes you may find useful if you plan to make extensive 
use of the Data Dump feature. If, at some point in the staff, you want to change only one of the 
additional two MIDI channels you’ve specified, create another note expression whose play-
back definition is a Data Dump. But in the Data text box that originally displayed the MIDI 
channel that you don’t want to change at this point, enter the code $FE. Example: Your first 
Data Dump expression added channels 5 and 6 to the staff’s playback; its Data boxes dis-
played $FF, 4, and 5. You want the additional channels now to be 5 and 12, so you create a 
new Data Dump expression; its Data boxes should display $FF, $FE, and 11.

Finally, you can “turn off” any additional MIDI channels you’ve specified with a Data Dump 
expression by entering $FF in the appropriate Data box. Example: Your first Data Dump 
expression added channels 5 and 6 to the staff’s playback; its Data boxes displayed $FF, 4, and 
5. You now want channel 5 to drop out, so you create a new Data Dump expression; its Data 
boxes should display $FF, $FF, and $FE (because $FE, remember, is the “don’t change this 
channel” command).

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, the settings you’ve 
made in this dialog box and return to the Expression Designer dialog box.

Executable Shape Selection dialog box
How to get there

Click the Expression Tool y, and double-click a note or measure. Click Create (or click an 

existing expression from the selection box and click Edit); click Playback Options; click Execute 
Shape; click Select.

What it does
Every Executable Shape that has been created or loaded into the document appears in this box, 
ready to be assigned as part of the playback definition for an expression.
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• Edit. If you want to modify one of the shapes appearing in the Executable Shape Selection 
box, click it once and then click the Edit button. You’ll enter the Executable Shape Designer 
dialog box, where you can modify Finale’s interpretation of the shape (or, by clicking Shape 
ID, you enter the Shape Designer, where you can modify the shape itself). 

• Create. Click Create to enter the Executable Shape Designer dialog box, where you can teach 
Finale how to interpret a certain shape. To draw the shape itself, click Shape ID and then Cre-
ate to enter the Shape Designer. See EXECUTABLE SHAPE DESIGNER DIALOG BOX and SHAPE 
DESIGNER DIALOG BOX.

• Duplicate. Click Duplicate to make a duplicate copy of the highlighted expression. You can 
select more than one item. Use Shift-click to select an additional item and include all the items 
in between. Use ctrl-click to select only a specific additional item in the list.

• Delete. After selecting a shape by clicking it, click Delete to remove it from the selection box. 
You can select more than one item. Use Shift-click to select an additional item and include all 
the items in between. Use ctrl-click to select only a specific additional item in the list. (You 
can’t delete it if it’s being used as part of the playback definition of an existing expression.)
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• Move Up • Move Down. Click these buttons to move the selected item or items up or down in 
the list. You can select more than one item. Use Shift-click to select an additional item and 
include all the items in between. Use ctrl-click to select only a specific additional item in the 
list.

• Cancel. Click Cancel to return to the Playback Definition box without specifying an Execut-
able Shape.

• Select. If you click one of the displayed shapes and then click Select, you’ll return to the Text 
Expression or Shape Expression Designer, where Finale will have automatically entered the 
number of the shape you selected in the Execute Shape text box. (You can simply double-click 
a shape instead of clicking once and then clicking Select.)

Executable Shape Designer dialog box
How to get there

Click the Expression Tool y, and double-click a note or measure. (If the note or measure 

already has an expression attached, ctrl-double-click.) Click Create (or click an existing shape in 
the selection box and click Edit). Click Playback Options; Execute Shape; Select; and Create (or 
click a shape and click Edit).

What it does
An Executable Shape is a line whose contours Finale “reads” as it plays back your music in order 
to produce changes over time of some musical aspect: tempo or volume, for example. You draw 
the Executable Shape itself in the Shape Designer (which you enter from this dialog box by click-
ing Shape ID, then clicking Create), but you define its characteristics in this dialog box.

For a more complete discussion of Executable Shapes, see EXPRESSIONS and SHAPE DESIGNER, as 
well as the entries for individual Executable Shape–driven expression markings such as CRE-

SCENDO/DECRESCENDO, RALLENTANDO, and TRILLS.

• Shape ID. The number in this text box identifies the particular shape that’s being used as an 
Executable Shape. If you don’t know the number of the shape you want to use—or if you 
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haven’t yet created it—click Shape ID; you’ll enter the Shape Selection box, where you can 
double-click the desired shape (or click Create to enter the Shape Designer, where you can 
create your own shape; see SHAPE DESIGNER DIALOG BOX). You’ll return to the Executable 
Shape Designer dialog box, where Finale will have entered the appropriate number in the 
Shape ID box.

• Time Scale. If you haven’t told Finale to do otherwise, it will “sample” (or consult the level 
of) an Executable Shape once every eighth note. For example, if you’re creating a rallentando 

that lasts for one measure of , Finale will decrease the tempo slightly in eight eighth-note 

increments, as shown:

The Time Scale, a ratio formed by the numbers in the two text boxes, lets you tell Finale to 
sample the shape more (or less) frequently. If, for example, you have a passage composed of 
sixteenth notes and you’ve created a rallentando that sounds too jerky, tell Finale to sample it 
twice as often (once every sixteenth note) by entering a Time Scale of 1:2. You enter 1:2 
because Finale “reads” the entire Executable Shape in one-half the time (by sampling the 
shape twice as often).

• Level Scale. The numbers in these two text boxes form a ratio that governs the amount by 
which Finale should change the tempo (or volume, or whatever parameter you’ve specified) 
over time. If you leave the Level Scale at 1:1, Finale examines the shape you’ve drawn in the 
Shape Designer; for every horizontal gridline the shape rises or falls, Finale changes the play-
back value by one degree, depending on the playback variable being affected. (In the Shape 
Designer, choose Grid from the Show submenu of the Shape Designer Menu to view the grid 
points.)

For tempo changes, “one degree” means one quarter note per minute (a metronome marking). 
For velocity, a degree means one MIDI velocity value (where 0 is silent and 127 is loud as 
possible). For MIDI patch or MIDI channel, each degree corresponds to a switch to the next 
patch or channel, and for pitch, a degree is a half step.

Suppose, therefore, that you’ve created a rallentando shape in the Shape Designer that looks 
like the one pictured below. When you enter the word “rall.” in the score (for which this Exe-
cutable Shape is the playback definition), you’ll hardly hear any tempo change at all in the 
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Tempo: 120 119 118 117 116 115 114 113
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playback. Based on what you now know, you’ll realize that it’s because your sloping line only 
drops two gridlines over its entire length. That means your rallentando only slows the tempo 
from 120 to 118 beats per minute!

This is an ideal problem for the Level Scale to solve. Just change the Level Scale to, say, 15:1; 
in other words, for every grid point your shape rises or falls, the tempo will increase or 
decrease by 15 beats per minute, not one.

• Sample Rate. As described above, the rate at which Finale “consults” the Executable Shape is 
determined by the Time Scale. However, you have even further control over the behavior of 
your playback expression, because the Sample Rate text box tells Finale to affect playback 
only on the Nth sample, where N is the number in the box. If, for some reason, you decide that 
a certain Executable Shape crescendo is too smooth, enter 2 in the Sample Rate box, and 
Finale will only change the volume every second time the Executable Shape triggers a change, 
ignoring the samples in between.

• Use List. If you want Finale to “notice” specific samples that you specify, select Use List. A 
dialog box appears, letting you enter a series of numbers, one in each text box (if there are 
more than four values in your list, use the right and left arrows to scroll to additional text 
boxes, but you can’t enter more than six). The numbers you specify here tell Finale which 
samples of the Executable Shape you want it to register for playback purposes. 

Use List can produce interesting effects if this Executable Shape governs pitch or Restrike 
Keys. (Restrike Keys is one of the playback definitions you can assign to any expression; the 
note to which it’s attached is struck over and over again, at a rate specified by its Time Scale 
setting.) By creating a sample list and entering your values carefully, you can create a Restrike 
Keys expression that plays a certain rhythm. Suppose, for example, your Restrike Keys shape 
is applied to a whole note, and has a Time Scale of 1:1 (it restrikes the note every eighth note). 
If you click Use List and enter 3, 3, and 2 in the first three boxes, the affected whole note 
would play back with this rhythm:

• Repeat Count. There may be times when you want the Executable Shape you’ve just defined 
to repeat itself several times. For example, if you’ve just designed a magnificent trill that lasts 
for only a quarter note—but you want to create a trilling whole note—you can tell Finale how 
many extra times you want the shape played by entering the number (in this example, 3) in the 
Repeat Count box. See TRILLS for additional examples.

• Log All. When sampling your Executable Shape, Finale generally only “notices” (or produces 
an audible playback change for) a sample when its value changes; a Restrike Keys expression 

&
b c
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whose Executable Shape is a horizontal line won’t restrike the note at all, because Finale 
doesn’t notice any changes in the line’s vertical value. If you want such a shape to generate a 
sample at each eighth note whether its value has changed or not, select Log All.

• Quit at End of Sample List. If you’ve specified a sample list by selecting Use List, and if the 
shape is long enough to produce more samples than the highest number you’ve entered in the 
Sample List, Finale will ordinarily start over at the beginning of the Sample List in deciding 
which samples to “notice.” If you’d rather have Finale respond only once to the specific sam-
ples named in the list—and not to repeat the action—select this option.

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, the Executable 
Shape settings you’ve made and proceed to the next dialog box.

Sample List for Executable Shape dialog box
How to get there

Click the Expression Tool y, and double-click a note or measure. Click the desired expression 

in the selection box, and click Edit; then click Playback Options. Click Execute Shape, and then 
Select; in the selection box that appears, either click an existing Executable Shape and click Edit, 
or click Create. In the Executable Shape Designer box, click Use List.

If the expression already appears in the score, ctrl-shift–double-click its handle, then click Play-
back Options, Execute Shape, Select, Create, and Use List.

What it does
An Executable Shape is a line whose contours Finale “reads” as it plays back your music in order 
to produce changes over time of some musical aspect: tempo or volume, for example. You draw 
the Executable Shape itself in the Shape Designer. (For a more complete discussion of Executable 
Shapes, see EXPRESSIONS and SHAPE DESIGNER, as well as CRESCENDO/DECRESCENDO, RAL-

LENTANDO, and TRILLS.)

Normally, Finale samples (consults the contour of) an Executable Shape at regular intervals. For 
example, Finale might sample the shape you’ve drawn for a rallentando every eighth note, so that 
the tempo decreases with each passing eighth note. 

If you want Finale’s playback to respond only to specific samples (instead of every sample), select 
Use List. This technical dialog box appears, where you can enter a series of numbers, one in each 
text box, to tell Finale which samples provided by the Executable Shape you want it to register for 
playback. See EXECUTABLE SHAPE DESIGNER DIALOG BOX for more information.
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• [Text boxes]. The numbers in these text boxes specify which of the samples generated by the 
Executable Shape you want Finale to “notice” (respond to) in creating the playback effect. 
Enter the sample numbers, in sequence, in the successive text boxes. Use the right and left 
arrow buttons to scroll the display to the right or left by one text box at a time; you can have up 
to six specified sample numbers.

• <<    >> [buttons]. Click the right or left arrow button to scroll through the six text boxes.

• Clear. Click Clear to reset the numbers in all the text boxes to 0. If you click OK at this point, 
Finale removes the X, if any, from the Use List checkbox, and will sample the Executable 
Shape at regular intervals in the usual way (every eighth note if the Time Scale is 1:1).

• OK • Cancel. Click OK (or press enter) to return to the Executable Shape Designer dialog 
box, where Finale puts an X in the Use List checkbox. The sequence of samples you entered 
will now repeat in an endless loop for as long as the Executable Shape (or the music it affects) 
lasts. (Endless, that is, unless you also select Quit at End of Sample List, in which case Finale 
only plays through your list once). Click Cancel to return to the Executable Shape Designer 
dialog box without changing the Sample List. (If you didn’t put numbers in any of the boxes, 
Finale doesn’t put an X in the Use List checkbox.)

Shape Selection dialog box
How to get there

Click the Expression Tool y, and double-click a note or measure. Click Shape. To create a new 

Shape Expression, click Create (or, to edit an existing Shape Expression, click it and then click 
Edit). Enter zero in the Select text box, and click Select.

This dialog box also appears when you’re choosing a multimeasure rest; a custom stem shape 
(Special Tools Tool); or an Executable Shape as part of the playback definition for an expression.

What it does
When you’re editing or creating a new Shape Expression, custom stem, Executable Shape, or 
multimeasure rest, this selection box lets you choose the shape on which to base it. If the Maestro 
Font Default file isn’t in place, and you haven’t loaded a Shape Expression Library or created any 
new shapes yourself, this selection box will contain only the hard-wired multimeasure rest shape.
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• Edit. After clicking a raw shape, click Edit to enter the Shape Designer, where you can edit it. 
(For a discussion of creating your own shapes, see SHAPE DESIGNER.)

• Create. Click Create to enter the Shape Designer, where you can “draw” your own shape.  See 
SHAPE DESIGNER.

• Duplicate. Click Duplicate to make a duplicate copy of the highlighted expression. You can 
select more than one item. Use Shift-click to select an additional item and include all the items 
in between. Use ctrl-click to select only a specific additional item in the list.

• Delete. Click Delete to remove a shape from the selection box. You can select more than one 
item. Use Shift-click to select an additional item and include all the items in between. Use 
ctrl-click to select only a specific additional item in the list. You can’t delete any shape that’s 
already being used (as a Shape Expression or Executable Shape, for example).

• Move Up • Move Down. Click these buttons to move the selected item or items up or down in 
the list. You can select more than one item. Use Shift-click to select an additional item and 
include all the items in between. Use ctrl-click to select only a specific additional item in the 
list.

• Cancel. Click Cancel to return to the previous dialog box without specifying a shape.
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• Select. After clicking one of the raw shapes in the selection box, click Select. You return to the 
previous dialog box.

Note that you can simply double-click a shape instead of clicking it and clicking Select.

Delete Element dialog box
How to get there

Click the Expression Tool y and double-click a note or measure, or the Articulation Tool t 

and click a note. (If the note already has an articulation attached, click again.) Select an articula-
tion or expression, then Click Delete.

What it does
This dialog box allows you to delete elements from the Articulation or Expression List and spec-
ify how to handle any elements of that type already in the score. You can replace them with 
another articulation or expression or you can just have them deleted.

• Delete element from selection palette and replace in score with: Select. Choose this option 
if you want to replace the deleted element with a different expression. Click Select to bring up 
the Articulation or Expression Selection dialog box where you can choose the new element.

• Delete element from both selection palette and score. Choose this option to delete the artic-
ulation or expression without replacing it in the score with another expression.

• OK • Cancel. Click OK (or press enter) to delete the expression. Click Cancel to return to the 
Articulation or Expression Selection dialog box without deleting anything.

Create Tempo Marking Plug-in
How to get there

Select a measure with the Mass Mover Tool. Select Create Tempo Marking from the Plug-ins 

Menu. See PLUG-INS MENU for more information.
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What it does
The Create Tempo Marking plug-in allows you to easily create a tempo marking as an expression 
and set the playback features for the selected measure.

• [Note value selection palette]. Select the note value you want to use in your tempo marking.

• [Tempo]. Type the tempo in this text box.

• Define Expression for Playback. Select this checkbox for the tempo marking to speed up or 
slow down the playback of the score.

• Create As: Measure Expression • Note Expression. Select whether you would like the 
tempo marking attached to measures or notes. If you choose Measure Expressions, your 
tempo marking will appear on all staves by default. Using the Staff List feature, you can spec-
ify which staves you want a given measure expression to appear in. See STAFF LIST DIALOG 
BOX.

• OK • Cancel. Click OK to create a tempo marking. Click Cancel to return to the score without 
making any changes.

Number Repeated Measures Plug-in
How to get there

Select Number Repeated Measures from the Plug-ins Menu. If there is no Mass Mover Selection 

when you invoke the Number Repeated Measures plug-in, it will ask you if you want to process 
the entire document. See PLUG-INS MENU for more information on plug-ins.

What it does
The Number Repeated Measures plug-in looks for runs of repeating measures in the current Mass 
Mover Selection. When it finds a run of three or more measures, it places repetition count num-
bers over the measures as a performance aid. This is done by creating expressions and placing 
them over the relevant measures.
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Using the Number Repeats Plug-in
Normally you will use the Number Repeated Measures plug-in after music has been entered and 
formatted. It is important to note that to position repeat numbers accurately, this plug-in needs for-
matting information from the Page View. You will have the most satisfactory results if you switch 
to Page View (and have Finale recalculate any changes to layout that are pending) before invoking 
the plug-in. See the NOTES section for more information. 

Use the Mass Mover Tool to select the measures that should be numbered. The plug-in will look 
for runs of at least three repeating measures and number them automatically, placing repeat count 
numbers over the middle of every measure in a run.

As you can see in the above example, Number Repeats also recognizes all appropriate Alternate 
Notation when looking for runs of repeating measures.

Notes
• IMPORTANT: The Number Repeated Measures plug-in needs information from the Page 

View of the current Staff Set to accurately calculate the correct position of the repeat count 
numbers. This information is not calculated by Finale until the first time you switch to Page 
View. If you have never viewed the current Staff Set in Page View when you invoke the Num-
ber Repeated Measures plug-in, the plug-in recognizes this condition and posts an Alert sug-
gesting that you switch to Page View first. Once Finale has calculated the Page Layout 
information, you are free to switch back to Scroll View if you prefer. You do not need to be in 
Page View when you use the plug-in. However, you should be aware that some editing 
changes can invalidate Finale’s Page Layout information (in particular, changing Alternate 
Notation). For most accurate results, it is a good idea to switch to Page View (even if you 
immediately switch back to Scroll View) before invoking Number Repeated Measures.

• When looking for runs of repeating measures, Number Repeated Measures compares mea-
sures and their entries, but ignores other attributes such as expressions, Articulations, or MIDI 
Performance information. Entries must be rhythmically identical and contain the same notes 
in order for the measure to count as a repetition. Also, measures must have the same Key and 
Time Signatures to qualify as a repetition.

• The Number Repeated Measures plug-in recognizes Alternate Notation (Slash Notation, 
Rhythmic Notation, and Single-Measure Repeat Notation) when looking for runs of repeating 
measures. In fact, use of Slash Notation and Single-Measure Repeat Notation overrides the 
normal rules used when testing for repetition. If a measure uses either of these two styles of 
Alternate Notation, it will always qualify as a repetition. Measures using Rhythmic Notation 
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must match on an entry-by-entry basis for rhythmic value, but the notes in the entries are 
ignored in the comparison. In short, Number Repeated Measures treats a measure as a repeti-
tion based on its appearance, not on playback.

• Number Repeated Measures positions the repetition count expressions one space (24 EVPUs) 
above the highest note or stem in the measure. The expressions are placed over the middle 
beat of the measure.

• Number Repeated Measures uses Text Expressions for the repetition count numbers. It is eco-
nomical in generating Text Expressions: it will not create a new Text Expression if an appro-
priate Expression is already available.

• Since the Number Repeated Measures plug-in will never put repetition count numbers over a 
run of only two measures, the command is disabled if the Mass Mover Selection is shorter 
than three full measures. Similarly, if your document only contains one or two measures, the 

Number Repeated Measures plug-in is disabled in the Plug-ins Menu.

Auto-Dynamic Placement Plug-in
How to get there

Select Auto-place Dynamics from the Plug-ins Menu. If you prefer to apply Auto-Dynamic Place-

ment to a specific region, select the region using the Mass Mover Tool before selecting the plug-in 

from the Plug-ins Menu. See PLUG-INS MENU for more information on plug-ins.

What it does
The Auto-Dynamic Placement plug-in allows you to place dynamics in your score automatically 
based on the recorded MIDI key velocity. You can specify the range of key velocities associated 
with each dynamic.



Auto-Dynamic Placement Plug-in 24-33      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

• Min. Velocity Change Between Dynamics. Change the number in this text box to vary the 
amount of velocity change required to place the next dynamic marking.

• Place By Entry • Place By Beat • Place By Measure. Select the one of these placement 
options to determine where dynamics should be placed. Place By Entry will place dynamics 
at every entry if there is a great enough change in Key Velocity (specified in Minimum Veloc-
ity Delta between Dynamics). Place By Beat will place dynamics at every beat where the 
change in key velocity is greater than the specific minimum. Place By Measure will place 
dynamics by measure where the average of the key velocities over that measure indicates a 
change in dynamic level.

• Avoid Accents. Deselect this checkbox to have the plug-in place dynamics on accented notes 
as well as unaccented notes.

• Dynamic Marking: pppp • ppp • pp • p • mp • mf • f • ff • fff • ffff. Select the dynamic from 
the drop-down list to change the minimum key velocity assigned to that dynamic level.

• Minimum Velocity. Enter the minimum key velocity for the selected expression in this text 
box. It is not influenced by the current text expression library.  The key velocity range is 0-
127.

• Expression. Click on Expression to select the a different expression not available from the 
Dynamic drop-down list.

• Placement: Layer 1 • Layer 2 • Layer 3 • Layer 4. Select the layer to place the dynamics 
into with this drop-down list.

• Placement: Voice 1 • Voice 2. Select which voice to place the dynamics into with this drop-
down list.
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• Place Above Staff. This checkbox will place the dynamic above this staff when selected.  
When this checkbox is not selected the dynamics will be placed below the staff.

• Distance from Staff. The number in this text box represents the distance from the staff the 
dynamic will be placed. The larger the number the farther away from the staff the dynamic 
will be placed, the smaller the number, the closer to the staff. This is measured from the top or 
bottom line of the staff depending on whether the Place Above Staff checkbox is selected or 
not.

• Minimum Distance From Entry. Place the desired minimum amount of distance between 
entries and dynamics in this text box. Even though you have set a specific distance from the 
staff, sometimes notes and rests above and below the staff may collide with dynamics unless 
you have specified that the dynamics must be placed some distance away (either above or 
below) the entries.

• OK • Cancel. Click OK to place dynamics using the specified settings. Click Cancel to return 
to the score without placing any dynamics.

Expressions
See also ARTICULATIONS; CRESCENDO/DECRESCENDO; DYNAMICS; SLURS.

There are two tools for creating and placing expression marks in Finale: the Articulation Tool and 
the Expression Tool.

The sets of symbols, expression marks, and shapes accessed by these tools are stored in libraries. 
Unlike many other music programs, which provide a permanent set of musical symbols that are 
always available to you, Finale gives you the option of loading your choice of symbol sets into 
each individual document. If you’re scoring a big band piece, you may want to create a library full 
of fall-off, bend, and “doit” markings—but you certainly won’t need those expressions when you 
write a string quartet. The File Menu in Finale offers two commands: Open Library, for bringing 
expression marks into a document, and Save Library, for storing symbols you’ve created or modi-
fied in a separate library of their own, ready to be imported into future pieces.

Unless you’ve removed the Maestro Font Default file from the Finale program’s folder, a basic set 
of Articulation and Expression markings is already installed (loaded) when you create a new doc-
ument. If the selection palette comes up empty when you’re attempting to place an expression in 
the score, it’s because the Maestro Font Default file (which came with the program) wasn’t in 
place. You can remedy the situation by choosing Open Library from the File Menu, locating the 
Libraries folder, and double-clicking the correct libraries (the Articulation Library for the Articu-
lation Tool, Text Expression Library and Shape Expression Library for the Expression Tool). But 
before you launch Finale again, place the Maestro Font Default file in the program folder so you 
won’t have to repeat this process every time you start a new document.

Expressions can be placed in the score as Note expressions or Measure expressions. Note Expres-
sions must be attached to a note or rest in a single staff. Measure expressions are attached to a 
measure, even an empty measure. Most importantly, Measure expressions can appear on more 
than one staff. Since Measure expressions can affect every staff in the score, it’s useful for 
rehearsal letters, tempo indications, and other markings as well as those that need to be directly 
attached to notes. You can even specify exactly which staves the Measure expression should 



Expressions 24-35      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

appear on by creating a Staff List. For example, you could create a Staff List to place a tempo 
change above each group of instruments, such as strings, woodwinds, and percussion. For a more 
complete discussion of Staff Lists, see STAFF LIST DIALOG BOX.

Tip: If you utilize Staff Lists and plan to copy this music from one document to another (or any-
where with the invisible clipboard), keep in mind that Finale can't know that the destination file 
contains the same Staff Lists as the source file. Therefore, all expressions will appear on all staves 
and you'll have to reconfigure the Staff Lists. (Shift-click the expression’s handle to re-access the 
Staff Lists.) To avoid this, copy the music prior to assigning expressions OR consider using note 
expressions on a staff by staff basis.

Measure expressions can place an expression in every staff, at precisely the same position. Move 
any marking and the ones in all other staves move simultaneously. If you click Individual Posi-
tioning when placing the marking, however, the marking in each staff becomes independently 
movable.

If you want to change a Measure expression’s positioning mode (Individual Positioning or not) or 
its Staff List assignment, shift–double-click its handle. The Measure Expression Assignment dia-
log box will reappear. To align expressions and Smart Shape crescendos, see the ALIGN/MOVE 
DYNAMICS PLUG-IN.

There are two subsets of expressions: Text Expressions (legato, arco, f, and so on) and Shape 
Expressions (slurs, hairpins, and so on). The Shape Expressions are created in the Shape Designer.

(Note: It’s a good idea, whenever possible, to use the Smart Shape Tool for slurs, hairpins, and 
dotted-line shapes. Not only do Smart Shapes produce the same high-quality printouts as Shape 
Expressions, but they’re intelligent—that is, they expand and contract along with the music 
they’re assigned to, and they automatically break into two independent shapes if the main shape 
happens to straddle a line break. A Smart Shape crescendo is normally just a graphic, but with a 
touch of the MIDI Tool or the Smart Playback plug-in, you can create a playback crescendo, too; 
see CRESCENDO/DECRESCENDO.)

For information regarding specific markings (tempo indications, crescendos, and so on), see their 
individual entries.

If you intend to make use of the Shape Expressions, it’s important that you assign each to a Meta-
tool (see “To create Expression Metatools,” for full instructions) before placing them in the score. 
Otherwise, you’ll find that the shapes aren’t individually reshapable; if you change one, they all 
change.

To create an expression

• Click the Expression Tool y. Double-click on, above, or below the note to which you 

want to attach the marking. The Expression Selection dialog box appears. 

If you’re placing a Shape Expression, click Shape. Remember, however, that if you intend to 
place more than one of the desired shapes into the score, you must place it into the music 
using Metatools (see “To create Expression Metatools”).

If the desired marking already appears in the list, click it and skip to the instruction marked by 
the asterisk (*).

• Click Create. The Text (or Shape) Expression Designer appears. 
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To create a Shape Expression, click Select; then click Create, which brings you to the Shape 
Designer. (See SHAPE DESIGNER.) Design your shape, press enter three times (making modifi-
cations to dialog boxes along the way, if you wish), and then skip to the instruction marked by 
the asterisk (*). 

• Type the Text Expression. Click Set Font to change the type style. (If your text is longer than 
96 characters, you’ll either have to split it into two separate expressions, or create a Text Block 
instead; see TEXT TOOL for instructions.)

• Click OK (or press enter). 

* Click Measure Expression or Note Expression. If you double-clicked by a note, Finale 
remembers this setting. 

• Click Select (or press enter). The Expression Assignment dialog box appears. You often 
won’t have any changes to make to this box, in which case you can go on to the next step. 
There are, however, some useful options here. 

For note expressions, from the Distance from drop-down list, choose Bottom Note if you want 
the marking positioned relative to the bottom note of a chord, so that it maintains its distance 
in the event the bottom note is transposed. If you don’t select this option, the mark will be 
attached to the top note of the chord.

There’s also an option called Begin Playback at, with two choices. You usually hear the play-
back effect of an expression at the moment Finale reaches the note to which it’s attached. By 
selecting Position in measure instead, you can tell Finale to execute the playback effects of the 
mark according to its horizontal position in the measure. In other words, you can make the 
playback effect take place slightly later or earlier by dragging the marking to the right or left 
in the score. And finally, you can specify the element of the music you want this expression to 
affect—a specific layer, chord symbols, and so on—by choosing it from the On playback, 
affect drop-down list. See NOTE EXPRESSION ASSIGNMENT DIALOG BOX for more information.

For measure expressions, Individual Positioning means that you’ll be able to move this mark-
ing independently in each staff. (If you don’t click this box, you move this marking in all 
staves at once when you move any one of them). The other feature of interest is the Staff List. 
Select a staff list from the drop-down list or select New Staff List to create a new staff list. You 
can also choose Edit to edit a currently defined staff list. See STAFF LIST DIALOG BOX for more 
details. 

• Click OK (or press enter). The marking appears in the score.

To move or delete an expression
See also ALIGN/MOVE PLUG-IN.

• Click the Expression Tool y.

• Click the note or measure to which the marking was attached. The marking’s handle 
appears.

Tip: If Show All Handles is selected in the Expression Menu, then all the handles for all 
expressions will be displayed.
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• Drag the handle to move the marking; select it and press delete to remove it. Once the 
handle is selected, you can also use the arrow keys to “nudge” the marking for fine position-
ing.

To erase Expressions from a region

• Click the Mass Mover Tool l. 

• Select the desired region. See SELECTING MUSIC for some region-selecting shortcuts. In any 
case, the Mass Mover Menu appears.

• Choose Clear Items from the Mass Mover Menu. The Clear Items dialog box appears.

• Proceeding through the dialog boxes, click as follows: Only Selected Items; Entries (or 
Measures); Note Expressions or Measure Expressions. 

• Press enter twice to exit the dialog boxes. 

To copy expressions
You can copy any musical element from one passage to another. In this discussion, the source 
measures are those that now contain the marking, and the target measures are those to which you 
want to copy them.

• Click the Mass Mover Tool l. 

• Choose Copy Entry (or Measure) Items from the Mass Mover Menu. The Entry Items (or 
Measure Items) dialog box appears.

• Select Note Expressions or Measure Expressions, and click OK. 

• Select the source measures. See SELECTING MUSIC for some selecting shortcuts.

• Drag the first source measure so that it’s superimposed on the first target measure. If the 
first target measure is offscreen, scroll to it; then, while pressing ctrl and shift simultaneously, 
click it. Unless you drag to a region directly above or below the source measures, the “How 
many times?” box appears.

• Specify the number of times you want the markings copied, and click OK. Finale only 
copies markings to notes that fall on the same beats as they did in the source measures. The 
markings maintain their positions relative to the noteheads.

To create a shape
See SHAPE DESIGNER.

To define an expression for playback

• Click the Expression Tool y. If you haven’t yet placed the mark in the score, double-click 

any note or measure. When the palette appears, click the desired symbol, click Edit, then skip 
the next two instructions.

• Click the measure or note to which the expression was attached. Its handle appears.

Tip: If Show All Handles is selected in the Expression Menu, then all the handles for all 
expressions will be displayed.

• Ctrl-double-click the handle. The Text Expression Designer dialog box appears.
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• Click Playback Options. The dialog box expands.

• From the Type drop-down list, choose the playback effect you want the marking to have. 
Many of these are self-explanatory: Tempo, Key Velocity, and so on. For a complete descrip-
tion of these items, see TEXT EXPRESSION DESIGNER DIALOG BOX.

• To set a specific value for this parameter, enter a number in the Set To Value box. The 
units for these items are usually what you’d expect. Tempo is quarter notes per minute. Key 
Velocity is MIDI velocity (0, silent; to 127, very loud). Transposition is in half steps (to trans-
pose up an octave, type 12 in the Set To Value box). 
When you’ve entered a value into the Set To Value box, you’re finished defining the shape for 
playback; press enter four times to return to the score.
The rest of these steps deal with creating playback definitions that change over time—for 
example, MIDI pitch wheel data (for a pitch bend), Tempo (for a ritard), Key Velocity (for a 
crescendo), and so on. 

• If the playback parameter is to change over time, select Execute Shape, and then click 
the Select button. The Executable Shape Selection box appears. If the desired shape appears 
here, double-click it and skip to the instruction marked by the asterisk (*).

• Click Create. In the next box, click Shape ID. In the next box, click Create. You’re now in 
the Shape Designer. For a more complete discussion of the Shape Designer, see SHAPE 
DESIGNER.

• Choose Rulers and Grid from the Shape Designer Menu. A box appears, asking you to 
specify the background grid increments.

• Click Eighth Notes, enter 1 in the text box, then click OK. From the Show submenu of 
the Shape Designer Menu, choose Grid. You should now see a network of grid points; each 
horizontal gridpoint represents an eighth note’s duration.

• Draw the Executable Shape. Again, see SHAPE DESIGNER. The type of line you’ll be drawing 
should be fairly intuitive—you’re drawing, in fact, a graph whose contour Finale will follow 
as it plays back your music. A ritard (or a diminuendo, for that matter) looks like a straight 
line, or gentle curve, sloping down. A pitch bend looks like a scoop down or up. A mordent or 
trill might look like a V or a W. For details on these individual markings, see separate entries 
for TRILLS; RALLENTANDO; PITCH WHEEL; and so on. 

As you draw, keep in mind that each imaginary vertical gridline represents an eighth note’s 
duration, and each horizontal gridline represents one change in value. If you’re creating a cre-
scendo, the volume will increase an equal amount each time your shape crosses a horizontal 
gridline. If you’re creating a rallentando, the tempo will decrease each time your shape crosses 
a horizontal gridline. In a later step, you’ll learn how to determine the rhythmic value of these 
gridlines—specifying, for example, whether the volume increases every eighth note or every 
sixteenth note. But for the moment, realize that the height of your shape (the number of hori-
zontal gridlines it crosses) determines how many changes in value there will be. (The shape 
for a rallentando that crosses eight horizontal gridlines will create eight small tempo changes 
when the expression to which it’s assigned is played back.)

• Press enter twice. You arrive at the Executable Shape Designer box. The two most important 
elements here are the Time Scale and Level Scale boxes. 
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• Enter a new Time Scale, if necessary. When you created the shape, you determined how 
long the playback effect would last (by the number of vertical gridlines your shape crossed). 
The Time Scale ratio—formed by a combination of the two text boxes—is multiplied by the 
length of the shape you drew so that you can change the total duration affected by the shape. A 
1:1 ratio means that each vertical gridline your shape crosses (in the Shape Designer) repre-
sents an eighth note duration. 

Suppose you’re defining the Executable Shape for a crescendo. If the shape you drew was only 
a quarter note long (two gridlines in the Shape Designer), the crescendo will last for exactly a 
quarter note—if you leave the Time Scale at 1:1. To make the crescendo last twice as long, 
change the Time Scale to 2:1. If you want it to last only a third as long, the Time Scale should 
be 1:3. The values you enter here determine the span of time affected by your shape.

• Enter a new Level Scale, if necessary. The Level Scale, like the Time Scale, is a ratio. 
Instead of determining how long the Executable Shape’s effect will last, the Level Scale deter-
mines how much change you’ll hear (in the MIDI parameter you’ve specified). When you 
designed your shape, each horizontal gridline crossed by your shape represented one change 
in MIDI value: a tempo change from 60 to 59 beats per minute, a MIDI key velocity change 
from 120 to 121, a transposition down one half step. By changing the Level Scale, you can 
multiply that number to create more dramatic changes in the playback effect. For a ritard, you 
might want to specify a Level Scale of 10:1, so that the tempo drops by 10 beats per minute 
for each horizontal gridline crossed by your shape.

* Click OK or Select in each dialog box until you return to the score. Listen to the effect of 
your Executable Shape. Can you even hear your ritard in playback? If not, increase the Level 
Scale ratio. Is your crescendo too brief? Then increase the Time Scale ratio. If you’re still puz-
zled, examine one of the predefined Text or Shape Expressions that use Executable Shapes: 
the crescendo hairpin, for example, or the rallentando expression.

To create Expression Metatools
When you have many articulations or expression marks to place in your score, you can use a 
Metatool to bypass all the dialog boxes and button-clicks required in the expression-placing pro-
cedures described above. A Metatool is simply a keyboard equivalent for a certain expression 
marking; you use letter or number keys on your keyboard. 

Furthermore, Expression Metatools are extremely important if you want to place more than one of 
any particular Shape Expression into the score. If you don’t place them into the score using Meta-
tools, you’ll find that the shapes aren’t individually reshapable; if you change one, they all change.

• Click the Expression Tool y. 

• While pressing shift, press any letter or number key. The key you press is the Metatool key 
to which you’re assigning the marking. When you do this, the selection box appears. If the 
marking isn’t present in the palette, you can create it in the usual way; see “To create an 
expression”, and see ARTICULATIONS for instructions on creating articulation markings.

• Double-click the desired marking. Press enter as necessary to exit the dialog boxes. You 
return to the score, having successfully prepared the Metatool for use. You’re now ready to 
place the marking in the score select the proper tool).
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• While pressing the appropriate letter or number key, click where you want the marking 
to appear. (Keep in mind that you must click on, above, or below a note to place an articula-
tion or note expression.) The marking appears in the score. Also be sure to check the state of 
the metatool menu items in the Expression Menu. See EXPRESSION MENU.

Again, remember to use this Metatool technique all the time if you plan to place Shape 
Expressions into the score; doing so will ensure that each occurrence of a shape is individually 
reshapable, because each time you use a Metatool, it creates a copy of the original shape. 

Accelerando
See also BEAMING: FEATHERED BEAMING.

The word accel. or accelerando is a Text Expression, which you put into your score with the 
Expression Tool. You can define it to affect playback, if you like.

To place the word “accelerando” into a score

• Click the Expression Tool y. 

• Double-click on, above, or below the note or measure to which you want to attach the 
marking. The Expression Selection dialog box appears. If you see the “accel.” expression in 
the list, change the setting for Measure Expression or Note Expression if you wish, double-
click it and press Enter; you return to the score. If you don’t see it, continue:

• Click Create. The Text Expression Designer dialog box appears.

• Type “accel.” or “accelerando.” Click Set Font to change the type style.

• Click OK or Select in each dialog box until you return to the score. To adjust the marking, 
drag its handle; to remove it, click the handle and press delete.

To define the expression for playback

• Click the Expression Tool y. If you haven’t yet placed the mark in the score, double-click 

any note. When the palette appears, click the desired symbol, click Edit, then skip to the 
instruction below marked by the asterisk (*).

• Click the measure or note to which the expression was attached. Its handle appears.

• Double-click the handle. The Text Expression Designer dialog box appears.

* Click Playback Options. The dialog box expands.

• From the Type drop-down list, choose Tempo. Select Execute Shape, then click the Exe-
cutable Shape Select button. As you proceed through dialog boxes, click Create; Shape 
ID; and Create. You’re now in the Shape Designer.
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• Choose Rulers and Grid from the Shape Designer Menu. Click Eighth Notes, type 1 into 
the Grid Lines Every: box, and click OK. From the Show submenu of the Shape 
Designer Menu, choose Grid. Your Shape Designer drawing area now shows a horizontal 
point for each eighth-note duration, so that you can specify how long you want the accele-
rando to last. Each horizontal gridline represents a one-point increase in tempo (from 150 to 
151 beats per minute, for example).

• Click the Line Tool R. Click on the small white circle (the origin) and drag toward 

the upper-right. Watch the numbers in the H: and V: numbers as you drag; stop when H: and 
V: both say 4.
You’ve drawn a graph (an Executable Shape) of the tempo during the accelerando. For each 
vertical gridline you crossed as you dragged to the right, the accelerando lasted another eighth 
note duration; for each horizontal gridline it crossed, the tempo increased one metronome 
point.
Therefore, to make the accelerando last for one half-note, it should cross four gridlines as you 
drag to the right. To make the tempo increase by 20 beats per minute, you might think you’d 
have to cross 20 horizontal gridlines on the way up. For now, however, cross only four, mean-
ing the tempo will only increase by four beats per minute.

• Click OK or Select in each dialog box until you reach the Executable Shape Designer 
dialog box. 

• In the Level Scale boxes, enter 8:1. You probably wouldn’t even be able to perceive the acce-
lerando if it only sped up by four points during a whole note. By changing the Level Scale, 
you’re multiplying the degree of accelerando. If you enter 8:1, the tempo will change by 32 
points—a much more satisfying accelerando. Note that at this point you could also specify a 
different Time Scale, which would determine how long the executable shape will last. When 
you designed the shape, it crossed four gridlines (eighth notes)—one half note. Change the 
Time Scale to multiply that amount; a Time Scale of 1:2 would make the accelerando last half 
as long (a quarter note), and 3:1 would create one that would last three times as long (six 
beats).

• Click OK or Select in each dialog box until you return to the score. Listen to the accele-
rando and see how it works. If it doesn’t speed up enough, increase the Level Scale. If it lasts 
too long, decrease the Time Scale. (The effect of the accelerando will vary according to the 
current tempo.)
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Brackets: Notes
This entry contains information on creating a bracket ([) used to indicate that several notes are to 
be played with the same hand (piano music) or by a divisi orchestral section (string music). For 
information on brackets that connect staves, see BRACKETS: STAVES. For information on triplet 
(and other tuplet) brackets, see TUPLETS.

A bracket that encloses a group of notes is created as an expression in the Shape Designer.

To create a note bracket
Important: If you’ll need to put more than one bracket into your score, be sure to place them using 
Expression Metatools (see EXPRESSIONS—To create Expression Metatools). If you don’t, you’ll 
discover that every bracket in the score changes shape when you edit any one of them.

• Click the Expression Tool y, and double-click the note to which the bracket will be 

attached. The Expression Selection dialog box appears.

• Select Note Expression. If the setting is not available, click Cancel, and double-click closer to 
the note.

• Proceeding through the dialog boxes, click as follows: Shape; Create; Select; Create. 
You’re now in the Shape Designer. The following instructions give measurements in points 
(1/72 inch). If you’ve been working in different units, choose Rulers and Grid from the Shape 
Designer Menu and select Points, with gridlines every 9 points. (If the grid isn’t visible, 
choose Grid from the Show submenu of the Shape Designer Menu.)

These instructions also assume that “.5 pt” is selected in the Shape Designer Menu’s Line 
Thickness command. You may also want to enlarge the drawing area by choosing (for exam-
ple) 200% from the View drop-down list.

• Click the Multiline Tool W. You’re about to draw a bracket, segment by segment. To use 

the Multiline tool, you drag to create the first line segment, click at each subsequent corner, 
and then double-click to complete the shape. To make your shape match the dimensions of the 
one pictured here, observe the H: and V: numbers as you move the cursor, and place your 
mouse clicks according to the table below. (Of course, you can always drag individual points 
into alignment after you’re finished drawing, using the Selection Tool.)

&
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• Draw the shape, as shown: 

You should have a neat, quarter-inch tall bracket. (For a bracket that faces to the left, use a 
negative 9 in the H: box instead.)

• Click OK and then Select to enter the Shape Expression Designer dialog box. Click 
Allow Horizontal Stretching to deselect it. Click OK or Select in the dialog boxes until 
you return to the score. 

To move, delete, or reshape a note bracket

• Click the Expression Tool y; then click the note to which the bracket was attached. 

Its handle appears.

Tip: If Show All Handles is selected in the Expression Menu, then all the handles for all 
expressions will be displayed.

• Drag the handle to move the entire shape. Click the handle and press delete to remove it. 
To stretch the shape, double-click the handle, and drag one of the eight bounding han-
dles that appear. To completely reshape the bracket, double-click it a second time, and 
drag its individual control-point handles. 

Character names
Character names (opera, musical theater) are Text Expressions entered into your score as expres-
sions. Once you’ve created these markings, you can save them into a Text Expression Library so 
that you can use them in other documents.

For full instructions for adding text markings to your score, see EXPRESSIONS. You may save time, 
when adding character names to your score, if you assign each name to a Metatool (a one-key 
shortcut); see EXPRESSIONS—To create Expression Metatools.

Action
H: 

value
V: 

value

Start at... 9 18

Drag to... 0 18

Click... 0 0

Double-click... 9 0



Divisi 24-44      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

Divisi
See also EXPRESSIONS.

A divisi indication is a normal Text Expression that you place in a part (such as a string part) to 
indicate that the section of players should split up—one group should read the top written notes 
and the rest should read the bottom written notes, for example. Use the Expression Tool to place 
the marking into the score.
Hint: If you want to create a bracket or “split up” marking as shown above, simply create a second 
Text Expression that consists only of a “less-than” marking (shift-comma), like this: <, or a left 
bracket, like this: [, so that you clearly indicate which notes are to be played by each group of 
players.

Doits
A doit is an effect often performed by brass instruments in which the player produces a kind of 
upward glissando after attacking the indicated note, producing the opposite of a “fall-off” effect. 
You can create the word “doit” as an expression (see EXPRESSIONS), and the line itself as a second 
expression (in this case, a Shape Expression). For instructions on creating a custom shape, see 
SHAPE DESIGNER; for information on creating an adjustable line in the score, see SLURS.

Note, too, that you can purchase special music fonts for use with Finale, some of which contain a 
selection of useful jazz symbols, including doits, especially Finale’s Jazz Font. See FONTS.

Dynamics
See also CRESCENDO/DECRESCENDO; KEY VELOCITY; AUTO-DYNAMIC PLACEMENT PLUG-IN, 
ALIGN/MOVE DYNAMICS PLUG-IN.
You can place dynamic markings either into all staves or one staff at a time.
Dynamics, along with other Text Expressions, are stored in a Text Expressions Library. If you’re 
not working from the Maestro Font Default file, as described in Installation & Tutorials, then 
you’d be wise to load the Text Expressions Library provided with the program, which saves you 
the trouble of creating dynamics anew.
Dynamics may be purely graphic or they may be defined for playback. (The predefined Text 
Expression dynamics provided with Finale have been defined for playback—but feel free to mod-
ify them, as described below.) If your synthesizer is velocity (touch) sensitive, you’ll hear Finale 
respond to these dynamic markings as the music plays back.
If you want to create dynamics for playback only, and don’t need the actual markings to appear in 

&

#

œ œ <
Divisi

œ
œ

œ
œ

? #
c ‰ j

œ
œ

œ
œ

œ
œb



Dynamics 24-45      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

the score, you can quickly edit key velocity over a selected region with the MIDI TOOL; see KEY 
VELOCITY for instructions.

To design a dynamic marking
If the Maestro Font Default file was in the same folder as the Finale program at the time you cre-
ated the current document, you can skip these instructions; the most common dynamic markings 
are already available.
Even if the Maestro Font Default file wasn’t present, you can choose Open Library from the File 
Menu, and double-click the Text Expressions Library in the Libraries folder. This process, too, 
will load the dynamic markings into the current piece. You only need to go through the following 
steps if you want to create your own dynamic marking, or if you simply want to learn the process.

• Click the Expression Tool y. Double-click any note or measure. The Expression Selec-

tion dialog box appears.
• Click Create. The Text Expression Designer appears.
• Type the letter that corresponds to the dynamic marking you want to create. A full list of 

the dynamic markings in the Maestro music font appears on the Quick Reference Card. For 

example, lower-case f is the f marking, capital F is the F marking, and so on.

• Click Set Font. Set the font to 24-point Maestro type, and click OK. You can use characters 
from other fonts if you prefer.

• Press enter twice to exit the dialog boxes. The Expression Assignment dialog box appears. If 
you want the new dynamic marking to appear in the score, click OK. If you simply want to 
add it to the palette without actually placing it into the score, click Cancel.

To insert a dynamic marking into the score
See also AUTO-DYNAMIC PLACEMENT.

• Click the Expression Tool y. 

• Double-click on, above, or below the note or measure to which you want to attach the 
marking. The Expression Selection dialog box appears. If necessary, you can scroll up or 
down to see more Text Expressions.

• Change the setting for Note Expression or Measure Expression if you wish, then double-
click the desired dynamic. If you’re placing a dynamic marking as a measure expression and 
you want to specify the staves in which it’s to appear, click the Staff List radio button and 
select a staff list already created (or new if you don’t see the one you want). In the Score col-
umn, click for each staff in which you want to place the dynamic (an X appears). (You can 
also specify whether or not the dynamic should appear in a staff’s extracted part by placing an 
X in the Part column. The Part column, incidentally, also determines which staves in the full 
score will be affected by the expression’s playback effects.) When you’re finished configuring 
the Staff List, click OK (or press enter).

• If you’re placing a measure expression, select Individual Positioning, if desired. Individ-
ual Positioning permits you to move the resultant dynamic marking independently in each 
staff. (If you don’t select this option, the mark will appear in the same place in every staff; 
when you drag any one, all others will move simultaneously.)

• Click OK (or press enter). 
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To move or delete a dynamic marking
See also ALIGN/MOVE PLUG-IN.

• Click the Expression Tool y. 

• Click the note or measure to which the marking was attached. Its handle appears.
• Drag the handle to move the marking; select it and press delete to remove it. 

To define a dynamic marking for playback
The dynamics preloaded into the Maestro Font Default file (as well as those in the Text Expres-
sion Library) have already been defined for playback. You can use these steps, however, to alter 
such definitions (to make a forte louder, for example).

• Click the Expression Tool y. 

• Click the note or measure to which the marking was attached. If the marking hasn’t yet 
been placed in the score and you simply want to edit its definition from within the Selection 
palette, double-click any measure or note; when the palette appears, click the marking in ques-
tion, click Edit, and skip the next instruction.

• Ctrl-double-click the marking’s handle. The Text Expression dialog box appears.
• Click Playback Options. The dialog box expands.
• From the Type drop-down list, choose Key Velocity. Enter a velocity value in the Set To 

Value box. The value you enter here is the MIDI key velocity value that Finale will apply to 
all the music, beginning at the point where it first encounters the dynamic marking and ending 
only when it encounters another marking. MIDI velocity is measured on a scale from 0 (silent) 
to 127 (very loud). If you’re editing a dynamic that came with Finale, you’ll notice that a 
velocity value has already been defined; feel free to change it. The changes you make only 
affect the definition of the dynamic marking in this document, although you can store this doc-
ument’s set of modified dynamic marks in a Text Expressions Library, ready for use in other 
documents, by choosing Save Library from the File Menu. Then you can “borrow” the modi-
fied markings for use in other documents.

• Click OK (or press enter) twice. 

Fall-offs
While a fall-off is musically not the same thing as a glissando, the technique Finale uses to pro-
duce an adjustable slanted line attached to a notehead is the same. See GLISSANDOS.

Flutter-tongue
The notation for flutter tonguing (flute and other instruments) varies. You can place the f.t. nota-
tion into the score as an expression (see EXPRESSIONS). Use a wavy line to indicate its duration; 
see TRILLS.

Mutes
Mute indications for brass or stringed instruments (such as Straight mute, con sord., Open, and so 
on) are usually placed an expressions in the appropriate staves in your score. See EXPRESSIONS for 
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instructions. If you want to create an open or closed symbol (
o

 or 
+

), see ARTICULATIONS.

Pedal markings
A pedal marking involves two separate symbols—one where the pedal is to be depressed (°), 

and another where it’s to be released (*). You can, if you wish, also use a dotted-line bracket. 

There are three ways to create pedaling indications in Finale. If the markings don’t need to be 
functional for MIDI playback, the easiest method is to place them in the score as Articulations. 
(For complete instructions on creating articulation markings, see ARTICULATIONS.)

If you want to create graphic and functional pedal markings, use the Expression Tool. If you only 
want to add pedaling to the playback of your piece (via MIDI), you may prefer to use the MIDI 
Tool. No graphic pedal markings appear in the score, but you’ll hear the pedaling on playback.

To create ° (pedal down) and * (pedal up) markings (Expression method)

• Click the Expression Tool y. 

• Double-click on, above, or below the note to which you want to attach the marking. The 

Expression Selection dialog box appears. If you’ve already created the ° marking, double-
click it. The Text Expression appears in the score, where you can adjust its position (see 
below). Make sure to check the Note Expression setting to ensure that you have the one you 
want.

• Click Create. The Text Expression Designer dialog box appears.

• Click Set Font. Set the font to Maestro 24, and click OK (or press enter). You return to the 
Text Expression Designer dialog box.

• While pressing alt, type 0161 on the numeric keypad. In the Maestro music font, alt–0161 
is the ° marking. (Shift-8 is the * marking.)

• Click OK or Select in each dialog box until you return to the score. Now click on, above, 
or below the note to which the * marking is to be attached. Repeat the steps above with the * 
marking (for which shift-8 is the Maestro equivalent).

To move or delete the expression ° and * markings 

• Click the Expression Tool y, and click the note to which the marking was attached. A 

handle appears on the marking.

• Drag the handle to reposition the marking; select it and press delete to remove it. 

To define the ° and * expressions for playback
You’ll need to define both markings for playback. The ° marking will send a “pedal down” mes-
sage to your synthesizer; the * marking will send a “pedal up” message.
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• Click the Expression Tool y. If you haven’t yet placed the markings in the score, double-

click any note. When the Expression Selection dialog box appears, click the marking, click 
Edit, then skip to the instruction marked by the asterisk (*).

• Click the note or measure to which the expression was attached. Its handle appears.

• Option-double-click the handle. The Text Expression Designer dialog box appears.

* Click Playback Options. The dialog box expands.

• From the Type drop-down list, choose Controller; in the Controller text box, type 64. In 
the Set To Value box, type 127. You’re defining the sustain pedal (controller 64) to go down 
(MIDI value 127).

• Press enter twice. Now you have to create a corresponding “pedal up” playback definition. If 
you haven’t yet placed the * marking in the score, click any note. When the Expression Selec-
tion dialog box appears, click the marking, click Edit, and then skip the next two instructions.

• Click the note to which the * marking was attached. Its handle appears.

• Double-click the handle. The Text Expression Designer dialog box appears.

• Click Playback Options, then choose Controller from the Type drop-down list. In the 
Controller text box, type 64. In the Set To Value box, type 0. You’re defining the sustain 
pedal (controller 64) to go up (MIDI value 0).

• Press enter twice.

To create ° (pedal down) and * (pedal up) markings (Smart Shape method)
Smart Shape pedal markings won’t have a playback effect, but you can add them separately with 
the MIDI Tool. See TO CREATE PLAYBACK PEDALING USING THE MIDI TOOL.

• Click the Smart Shape Tool W. The Smart Shape Palette appears.

• Click the Custom Line Tool .
• From the Smart Shape Menu, choose Smart Shape Options. The Smart Shape Options dia-

log box appears.
• From the Smart Line Style drop-down list, choose Custom Line.
• Click Select next to Smart Line Style. The Smart Line Style Selection dialog box appears. If 

this file was created from a default file or template, you should see a Pedal and * line already 
created. If so, click Select and OK and skip to the instruction marked with a *. Otherwise, 
continue and create the Smart Line from scratch.

• In the Smart Line Style Selection box, click Create. The Smart Line Style dialog box 
appears.

• From the Line Style drop-down list, choose Character. Near Character, click Select and 
double-click on the blank character in slot 32. Check the Horizontal box to freeze the 
shape in a horizontal line.

• In the Text area, click on the Edit button next to Left Start. The Edit Text dialog box 
appears.

• From the Text Menu, choose Font. Set the font to Maestro 24. Click OK.
• While pressing alt, type 0161 on the numeric keypad. In the Maestro music font, alt–0161 

is the ° marking.
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• Click OK. Repeat the steps for the Right End, only type shift-8 for the ****.
• Click OK, Select and OK until you return to your score. For more information, see CUS-

TOM LINES.
* Double-click where you want the line to begin; on the second click, hold the button down 

and drag diagonally. Release the mouse when the line has the length you want.

To draw a pedal on/off diagram (Smart Shape method)
Sometimes pedaling is indicated in a score like this:

The Smart Shape method is easy and the line will expand and contract with the measures. The 
Expression method described below is more complicated, doesn’t expand and contract, but does 
allow you to associate a playback effect with the marking. Keep in mind, you can add a pedal 
playback effects with the MIDI Tool. See TO CREATE PLAYBACK PEDALING USING THE MIDI 
TOOL.

• Click the Smart Shape Tool W. The Smart Shape Palette appears.

• Click the Custom Line Tool .
• From the Smart Shape Menu, choose Smart Shape Options. The Smart Shape Options dia-

log box appears.
• From the Smart Line Style drop-down list, choose Custom Line.
• Click Select next to Smart Line Style. The Smart Line Style Selection dialog box appears. If 

this file was created from a default file or template, you should see several pedal on/off lines 
already created. (You may need to scroll down to see them.) If so, click Select and OK and 
skip to the instruction marked with a *. Otherwise, continue and create the Smart Line from 
scratch.

• In the Smart Line Style Selection box, click Create. The Smart Line Style dialog box 
appears.

• Check the Horizontal box to freeze the shape in a horizontal line.
• For the End Point Style, choose a hook and enter a vertical distance for either the begin-

ning or the end of the line. You can also choose a Custom Arrowhead for the pedal point. For 
more information, see CUSTOM LINES.

• Click OK, Select and OK until you return to your score.
* Double-click where you want the line to begin; on the second click, hold the button down 

and drag diagonally. Release the mouse when the line has the length you want.

To draw a pedal on/off diagram (Expression method)
You can create this shape in the Shape Designer, then assign it a playback effect with the method 
above.

• Click the Expression Tool y, and double-click the note at which you want the pedal 

line to begin. The Expression Selection dialog box appears.
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• Proceeding through the dialog boxes, click as follows: Shape; Create; Select; Create. 
You’re now in the Shape Designer.

The following instructions give measurements in points (1/72 inch). If you’ve been working in 
different units, choose Rulers and Grid from the Shape Designer Menu, select Points and click 
OK. To make your work match the illustration below, also choose Grid from the Show sub-
menu of the Shape Designer Menu.

These instructions also assume that “.5 pt” is selected in the Shape Designer Menu’s Line 
Thickness command.

• Click the Multiline Tool W. You’re about to draw a pedal line, segment by segment. To use 

the Multiline tool, you draw the first line segment, click at each subsequent corner, and then 
double-click to complete the shape. To make your shape match the dimensions of the one pic-
tured here, observe the H: and V: numbers as you move the cursor, and place your mouse 
clicks according to the table below. (Of course, you can always drag individual points into 
position, using the Selection Tool, after you’ve drawn the shape.)

• Draw the shape as shown: 

 

• Click OK or Select in each dialog box until you return to the Expression Selection dialog 
box (the one you began with), then click Cancel. You clicked Cancel so that your new mark-
ing won’t yet appear in the score. It’s important that you place this Shape Expression, like all 
Shape Expressions, into the score using a Metatool (a one-click keyboard equivalent). See 
EXPRESSIONS for instructions on creating Metatools, and for details on placing these markings 
into the score, moving them, and reshaping them.

To stretch the pedal marking once it’s in the score, double-click its handle; its bounding han-
dles appear. Double-click again; this time, you’ll see the individual “control point” handles 
that let you drag individual line segments. Drag-enclose the three rightmost handles, and drag 
right or left to extend the shape.

Action
H: 

value
V: 

value

Start at... 0 0

Drag to... 72 0

Click... 82 18

Double-click... 92 0

1 2

3

4
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To create playback pedaling using the MIDI Tool
If you don’t need pedal markings to appear in your score, but want to add the use of the sustain 
pedal to the playback of your score, you may find the following method faster than the Expression 
method.

• Click the MIDI Tool p. The MIDI Tool Menu appears.

• Double-click the measure in which you want the pedal to be “pressed.” The MIDI Tool 
split-window opens.

• Choose Continuous Data from the MIDI Tool Menu. The View Continuous Data dialog 
box appears, in which you can select a controller whose data you want to edit.

• Click OK (since Sustain Pedal is already selected). You return to the MIDI Tool split-win-
dow, where the display has changed. On the left side you see a scale of controller values—in 
this case, sustain pedal values—from 0 (pedal up) to 127 (pedal down). The sustain pedal is 
called a noncontinuous controller, because its value can’t change smoothly over time (like 
pitch wheel data can). You’ve either pressed the pedal (value 127) or released it (value 0). 
Unless you’ve already created pedaling using the MIDI Tool (or by capturing a Transcription 
Mode performance that included use of the sustain pedal), the window is empty.

Pedaling will appear in this window in bar graph form. In the example below, the pedal was 
depressed just after the second beat of measure 1, and released just after the fourth beat:

Controller information is independent of the actual notes being played—you can press the 
pedal even during a measure of rests, if you want. Therefore, you specify where you want to 
insert a “pedal down” message (or another noncontinuous controller, or a patch change) by 
dragging through a sliver of the graph area.

• Drag through a small horizontal “slice” at the beginning of the graph area, as shown. 
Keep in mind that the actual pedal usage will occur at the beginning of the region you select 
(indicated by the arrow in the figure below). It really doesn’t matter, therefore, how much of 
the window you highlight; the pedaling message will be inserted at the far left edge of your 
highlighted region.



Pizzicato 24-52      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

• Choose Set To from the MIDI Tool Menu. The Set To dialog box appears. Remember that to 
create the “pedal down” message, you need to set the pedal’s MIDI value to 127.

• Type 127. Click OK. You return to the MIDI window. Suddenly the entire graph area is black. 
That’s because you’ve just inserted a “pedal down” message without any corresponding 
“pedal up” message. Therefore, your synthesizer will think that the pedal is being pressed dur-
ing the entire piece.

• Drag through a small region of the graph area at the point where you want the pedal 
released. If the pedal release point isn’t in the same measure, click the right arrow button to 
scroll the music display.

Remember that the “pedal up” message will fall at the beginning of your selected region.

• Choose Set To from the MIDI Tool Menu. Click OK. You don’t have to enter a number, 
because the default value is already zero.

When you return to the window, click anywhere except in the graph area to remove the selec-
tion highlighting.

• Click the MIDI Tool to close the MIDI Tool split-window. You return to the score.

Once you’ve created one complete usage of the pedal, as you’ve just done, you don’t have to 
create it again in other measures that should contain a similar pedaling pattern. You can simply 
copy the pedaling from measure 1 into other measures. See MIDI Tool split-window—To 
copy or erase captured (or edited) MIDI data.

Pizzicato
The pizzicato marking (pizz.) is an expression; for complete instructions on creating and manipu-
lating expressions, see EXPRESSIONS.

If you want to define the pizzicato marking for playback, you have several options. If your synthe-
sizer has a pizzicato sound (or patch), you could define the pizz. marking as a patch change (see 
PATCHES). (If you use this method, you’ll also have to create a second expression—which can be 
invisible, if you prefer—to restore the playback to its original patch.) You might also consider 
placing the pizzicato notes in a separate staff layer, then using the Instrument List to specify a spe-
cial patch for that layer.
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A simpler method might be to create such a patch change using the MIDI Tool. Again, see 
PATCHES. If you simply want to hear selected notes play back with a staccato sound, see STAC-

CATO MARKS.

Rallentando
In Finale a rallentando can be a playback effect, a graphic marking in the score, or both. The Rall. 
marking itself can appear in one staff or several specified staves.

To place the Rall. marking into a score

• Click the Expression Tool y. 

• Double-click on, above, or below the note or measure to which you want to attach the 
marking. The Expression Selection dialog box appears. If the marking already appears in the 
list, click it and skip to the instruction marked by the asterisk (*).

• Click Create. The Text Expression Designer dialog box appears.

• Type “Rall.” or “Rallentando.” Click Set Font to change the type style (to italic type, for 
example).

* Click OK or Select in each dialog box until you return to the score. 

To move or delete a Rall. marking

• Click the Expression Tool y. 

• Click the measure or note to which the marking was attached. If Show all Handles it not 
selected from the Expression Menu, its handle appears.

• Drag the handle to move the marking. Select it and press the arrow keys to “nudge” it 
for fine positioning. Select it and press delete to remove it. 

To define a Rall. marking for playback

• Click the Expression Tool y. If you haven’t yet placed the marking in the score, double-

click any note. When the Expression Selection dialog box appears, click the desired symbol, 
click Edit, and then skip ahead to the instruction marked by the asterisk (*).

• Click the measure or note to which the marking was attached. Its handle appears.

• Ctrl-double-click the handle. The Text Expression Designer dialog box appears.

* Click Playback Options to expand the dialog box. From the Type drop-down list, choose 
Tempo; select Execute Shape, and click the Executable Shape Select button. Proceeding 
through the dialog boxes, click as follows: Create; Shape ID; Create. You’re now in the 
Shape Designer.

• Choose Rulers and Grid from the Shape Designer Menu. The Ruler and Grid dialog box 
appears.
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• Click Eighth Notes, type 1, and click OK. From the Show submenu of the Shape 
Designer Menu, choose Grid. The grid appears; each imaginary vertical gridline represents 
an eighth note’s duration; each horizontal line represents a tempo change of one beat per 
minute.

• Click the Line Tool R. You’re about to draw a graph of the rallentando’s effect on play-

back. To use the Line Tool, you drag it across the drawing area. To make your shape match the 
one pictured here, observe the H: and V: numbers as you move the cursor, and stop when the 
H: number is 4 and the V: number is –5.

• Draw a line, as shown: 

You should have a line that slopes downward from the small white circle. In this example, its 
width (the H: measurement) is 4, meaning four eighth notes’ duration; this rallentando will 
last for a half note. The line’s height, 5, represents the number of beats per minute the tempo 
will be slowed by this rallentando—at the moment, that’s not much of a tempo change. You’ll 
have a chance to adjust both of these effects.

• Press enter twice to exit the Shape Designer. 

• In the Level Scale boxes, enter 8:1. You probably wouldn’t even be able to perceive a ral-
lentando that only slowed down by five beats per minute. By changing the Level Scale, you’re 
multiplying the degree of rallentando. If you enter 8:1, the tempo will change by 40 beats per 
minute—a much more satisfying rallentando.

Note that, at this point, you could also specify a different Time Scale, which would determine 
how long the executable shape will last. When you designed the shape, it crossed four grid-
lines (each representing an eighth note duration, for a total of one half note). Change the Time 
Scale to multiply that rate of rallentando; a Time Scale of 1:2 would create a rallentando last-
ing half as long (a quarter note), and 3:1 would create a rallentando that lasts three times as 
long.

• Click OK or Select in each dialog box until you return to the score. Listen to the ral-
lentando in playback and see how it works. If it doesn’t slow down enough, increase the Level 
Scale. If it lasts too long, decrease the Time Scale. (The effect of the rallentando will vary 
according to the current tempo.)

To return to the original tempo after a rallentando (a tempo)

• Click the Expression Tool y. 



Tempo markings 24-55      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

• Double-click on, above, or below the note or measure to which you want to attach the 
marking. The Expression Selection dialog box appears.

• Click Create. The Text Expression Designer dialog box appears.

• Type “a tempo.” Click Set Font to change the type style (to italic type, for example).

• Click Playback Options to expand the dialog box. From the Type drop-down list, choose 
Tempo.

• Choose the note duration that is your time signature’s beat duration. If you are in 2/4, 
3/4, or 4/4 time, choose the quarter note. If you are in 2/2 or 3/2 time, choose half note. If you 
are in 3/8, 6/8 or 9/8 time, choose the eighth note or dotted quarter note.

• Click on Set and enter the tempo you want it to playback.

• Click OK then Select. In the Assignment box, click the desired option in the Begin Play-
back area. Make any other desired changes and click OK.

Tempo markings
A tempo marking in Finale can be purely graphic or it can be defined for playback. Several of 
these markings have been predefined and stored in a Text Expressions Library. If you load such a 
library (or if your Maestro Font Default file, which already contains these markings, is in place), 
you won’t have to create the markings anew. See also CREATE TEMPO MARKING and ENGRAVER 
FONT characters.

Once these Text Expressions have been loaded into your document (or created), you can place 
them into the score as expressions.

To place a tempo marking in the score

• Click the Expression Tool y. 

• Double-click on, above, or below the note or measure to which you want to attach the 
marking. The Expression Selection dialog box appears.Make sure to check your Note 
Expression setting to verify that you’re placing a note expression or a measure expression.

• Click Create. The Text Expression Designer dialog box appears.

• Type the text for the tempo marking. You can enter Allegro, Moderato, or whatever marking 
you want. Click Set Font if you want to change the type style (italic, for example). (To create 
metronomic tempo markings, such as q=60, for example, see METRONOME MARKINGS.)

• Click OK or Select in each dialog box until you return to the score. The tempo indication 
appears in the score.

To move or delete a tempo marking

• Click the Expression Tool y. 

• Click the measure or note to which the tempo marking was attached. If Show all Handles 
it not selected from the Expression Menu, its handle appears.
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• Drag the handle to move the tempo marking. Select it and press the arrow keys to 
“nudge” it for fine positioning; select it and press delete to remove it. 

To define a tempo marking for playback

• Click the Expression Tool y. If you haven’t yet placed the marking in the score, double-

click any note or measure. When the Expression Selection dialog box appears, click the 
desired marking, click Edit, and then skip to the instruction marked by the asterisk (*).

• Click the measure or note to which the tempo marking was attached. Its handle appears.

• Double-click the handle. The Text Expression Designer dialog box appears.

* Click Playback Options. The dialog box expands.

• From the Type drop-down list, choose Tempo; then enter a number in the Set to Value 
box. The number you type into the box is a standard metronome setting. (This setting is mea-
sured in quarter notes per minute, but you can change it to half notes—or any other value—
using the Tempo drop-down list.) You’ve just defined the Text Expression to change the play-
back tempo to this setting whenever the marking appears in the score.

• Click OK (or press enter). Any time Finale encounters the expression you’ve just defined 
when it plays back your score, the tempo will change to reflect the expression’s playback def-
inition.

Grand Pause
Use the Expression Tool to place the G.P. marking in all staves. If you plan to extract parts or to 
optimize staves, you must make sure that the Grand Pause measure doesn’t get grouped into a sin-
gle multimeasure rest in the extracted parts. 

To create a G.P. marking

• Click the Expression Tool y, and double-click above or below the G.P. measure. The 

Expression Selection dialog box appears.

• Click Create. The Text Expression Designer dialog box appears.

• Type G.P. Click Set Font to change the type style.

• Click OK or Select in each dialog box until you return to the score. 

To move or delete the G.P. marking

• Click the Expression Tool y. 

• Click the measure to which the marking was attached. If Show All Handles is not selected 
from the Expression Menu, its handle appears.

• Drag the handle to move the marking. Select it and press the arrow keys to “nudge” it 
for fine positioning; select it and press delete to remove it. 
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To force a break in a multimeasure rest
This step is important if you want the G.P. always to appear as an independent single measure in 
the extracted parts.

• Click the Measure Tool z, and select the G.P. measure and the measure before it. 

• Select Edit Measure Attributes from the Measure Menu. Or, you can double-click in the 
measure. The Measure Attributes dialog box appears.

• Select Break a multimeasure rest and click OK (or press enter). When you create multi-
measure rests, the G.P. marking will appear in a single independent measure.

Metronome markings
Because a metronome marking generally appears in all parts, it’s best to create it as a measure 
expression, which allows you to specify in which staves it will appear. See also CREATE TEMPO 
MARKING Plug-in and ENGRAVER TEXT FONTS - TEMPOS.

To create a metronome marking (such as q=120)

• Click the Expression Tool y. 

• Double-click above the measure to which you want to attach the marking. The Expression 
Selection dialog box appears.

• Click Create. The Text Expression Designer dialog box appears.

Create the metronome marking by typing the appropriate numbers on the numeric key-
pad (with num lock on), while pressing the alt key.

In the Maestro music font, the x, e, q, h, and w characters correspond to the x, e, q, h, and w symbols, respectively; 
a lower-case k produces the dot; alt–0200 creates the equal sign; and the small numbers are produced using alt 
characters according to the table below.

Keystrokes Resultant marking:

Lower-case x, then alt+0200, then alt–characters
x =¶™

Lower-case e, then alt+0200, then alt–characters
e =¶™

Lower-case q, then alt+0200, then alt–characters
q  =¶™

Lower-case q, then lower-case k, then alt+0200, then alt–characters
qd  =¶™

Lower-case h, then alt+0200, then alt–characters
h  =¶™

Lower-case w, then alt+0200, then alt–characters
w  =¶™
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As you type (in the Text Expression Designer), all you’ll see are strange symbols. When the 
completed Text Expression appears in the score, however, they’ll be translated into the Mae-
stro font equivalents to produce the appropriate tempo marking.

• Click Set Font. Set the font to Maestro 24 point, and click OK. Of course, you can choose 
a larger or smaller point size if you want the tempo marking to appear larger or smaller.

• Click OK or Select in each dialog box until you return to the score. 

To move or delete the marking

• Click the Expression Tool y. Click the measure to which the marking was attached. 

Its handle appears.

• Drag the handle to move the marking; select it and press delete to remove it. 

To define the metronome marking for playback

• Click the Expression Tool y. If you haven’t yet placed the marking in the score, double-

click any measure. When the palette appears, click the metronome marking, click Edit, then 
skip to the instruction marked by the asterisk (*).

• Click the measure to which the marking was attached. If Show all Handles it not selected 
from the Expression Menu, its handle appears.

• Ctrl-double-click the handle. The Text Expression Definition box appears.

* Click Playback Options to expand the dialog box. From the Type drop-down list, choose 
Tempo. In the Set to Value box, enter the metronome setting. For example, if your tempo is 
q =60 beats per minute, type 60 in the Set to Value box. (You can change the rhythmic unit by 

choosing it from the Tempo drop-down list; you could, for example, specify h =60 just as eas-
ily.)

• Click OK (or press enter). 

Keystroke
Resultant 
marking:

Keystroke
Resultant 
marking:

alt+0193
¡

alt+0164
§

alt+0170
™

alt+0166
¶

alt+0163
£

alt+0165
•

alt+0162
¢

alt+0187
ª

alt+0176
∞

alt+0188
º
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To create complex metronome markings
The usual method of creating metronome markings (above) is quick and easy, but it can’t handle 
sophisticated tempo indications like these:

In these cases, you can use Finale’s Ossia Tool to create metronome indications as complex as you 
wish. In effect, you’ll create a floating ossia measure with no staff lines; only its contents will 
appear. Before you print, you can delete the scratch staff.

If you just want the swing indication, we’ve provided one as a Shape Expression in your default 
library.

• Choose Scroll View from the View Menu, if you’re not already there. To create a floating 
ossia measure, you need to create a “scratch staff” on which to notate its actual contents.

• Click the Staff Tool s, and double-click the place where you want the scratch staff to 

appear. A new staff appears where you double-click.

To create a complex metronome marking, notate it on a “scratch” staff. Attach the equal sign as an 
Articulation, then turn the entire measure into a floating Ossia measure.

• In the scratch staff, enter the music you want to appear in the floating measure. To create 
an equal sign, attach it as an Articulation mark to one of the notes; see ARTICULATIONS.

• Click the Ossia Tool j. Double-click the measure to which you want to attach the 

metronome marking. The Ossia Measure Designer dialog box appears.

• Enter the number of the Source Staff and Source Measure. The Source Staff is the scratch 
staff, and the Source Measure is the measure in which you entered the music. (If you don’t 
know a staff’s number, click its handle with the Staff Tool and select Staff Usage from the 
Staff Menu. The Staff Usage dialog box that appears tells you the staff number.)

• Hide everything. Deselect everything under the words Items to Display: Clefs, Repeats, Staff, 
and so on, so that nothing will appear but the notes. You can also adjust the marking’s size by 
changing the Scale to setting (100% is the normal music size).

œ =œ

3

œ

j

œ

Clarinet &

&

b

b

c

c

1

∑

1

œ =œ

3

œ

j

œ
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• Press enter twice. You return to the score, and the Ossia Measure is in place. Click the “real” 
measure to which you attached it; a handle appears on the floating measure, allowing you to 
drag it into position. See also OSSIA—To move, edit, or delete a floating measure.

Rehearsal letters
A rehearsal letter (or number, or other mark) is a form of expression: it appears at the same loca-
tion in more than one staff. Because it’s an expression, you can specify one set of staves to display 
the mark in the full score, and a different set to receive the mark when the parts are extracted.
If you want your rehearsal marks to be based on their measure numbers, see MEASURE NUMBERS 
for an alternate method of creating rehearsal numbers.

To create a rehearsal letter

• Click the Expression Tool y. 

• Double-click on or above the measure at which the letter is to appear. The Expression 
Selection dialog box appears. If you see the letter in the scrolling list, double-click it and skip 
to the instruction marked by the asterisk (*).

• Click Create. The Text Expression Designer dialog box appears.
• Type the letter (or number). Click Set Font if you want to change the type style.
• If you wish, check Break Multimeasure Rest. If you check this box, Finale will always cre-

ate two multimeasure rests that break at the barline where this expression is added.
• If you wish, click Enclose Expression. The Enclosure Designer dialog box appears. Choose 

the shape you prefer from the list of geometric enclosures. Drag the top handle to make the 
enclosure taller or shorter, the right-side handle to make the whole enclosure bigger or 
smaller, and the middle handle to position the enclosure around the letter. You can also change 
the line thickness, which is measured in points (72 per inch). The second text box holds a dec-
imal place. Click Use Enclosure to exit the Enclosure Designer.
Note: Enclosed rehearsal numbers may not look the same when printed by a PostScript printer 
as they appear on the screen. You may need to experiment to find the correct adjustment; in the 
meantime, remember that the Show PostScript Preview command (in the View Menu, only in 
Page View) will help you preview the printed output before you commit the score to paper.

• Click OK (or press enter) twice. You arrive at the Measure Expression Assignment dialog 
box. 

* If you want to display the letter only in certain staves, click the Staff List button and 
select the staff list from the drop-down list. Or, if you don’t see the staff list you want, select 
New List and the Staff List dialog box appears. See STAFF LIST DIALOG BOX for more infor-
mation.

• Click OK (or press enter) to exit the Staff List box. The next time you place a rehearsal let-
ter in the score, you won’t have to select New List and rebuild the list; just select the Staff List 
from the drop-down list.
At this point, you may also want to select Allow Individual Positioning if you want the letter 
to be independently movable in every staff.

• Click OK (or press enter). 
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To move or delete a rehearsal letter

• Click the Expression Tool y; then click the measure to which the letter was attached. 

If Show all Handles it not selected from the Expression Menu, its handle appears.

• Drag the handle to move the letter; select it and press delete to remove it. If you want to 
edit the letter’s Staff List click the Edit button.

Masks
To mask a portion of a staff, you’ll create a solid white rectangle as a Shape Expression. By plac-
ing this rectangle over part of a staff, you can make the staff appear to end in mid-system. It’s 
much easier to hide entire portions of the staff using staff styles. See STAFF STYLES DIALOG BOX.

When placing Shape Expression masks, you must be careful to attach the shape to the appropriate 
note, as it affects how the staff and notes are covered. If you want to cover the staff lines, as well 
as all the notes on a staff, you must select a note after the region to be hidden. If you select a note 
before the region to be hidden, the staff lines will be covered, but notes and expressions will 
“show through” your shape. 

If you need to place more than one of these special shapes into your score, you must do so by 
using Expression Metatools. If you don’t, you’ll be resizing all occurrences of the shape any time 
you resize or reshape any one of them. For full instructions, see EXPRESSIONS—To create Expres-
sion Metatools.

To mask a portion of a staff

• Click the Expression Tool y, and click a note or a measure in the staff you want to 

mask. Click a note at the appropriate end of the staff. The Expression Selection dialog box 
appears.

• Click Shape. Proceeding through the dialog boxes, click as follows: Create; Select; Cre-
ate. You arrive in the Shape Designer. You’re about to draw a mask that’s the height of a stan-
dard staff and two inches wide. 

The following instructions give measurements in points (1/72 inch). If you’ve been working in 
different units, choose Rulers and Grid from the Shape Designer Menu and select Points.

• Click the Rectangle Tool S. Note the origin, the small white circle.

• Click the origin; without releasing the mouse, drag up and to the right, until the number 
in the “H:” box is 144 and the “V:” box is 28. You’ve just drawn a rectangle.

• Click the Selection Tool c, and select the rectangle. From the Fill submenu of the 

Shape Designer Menu, choose White. The inside of the rectangle turns white, but the outline 
is still black.

• From the Line Thickness submenu of the Shape Designer Menu, choose None. The black 
line goes away.



Masks 24-62      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

• Click OK or Select in each dialog box until you return to the score. The shape appears in 
the score as a whited-out rectangle. 

Note: The effect the white object has on your score depends on how it’s attached. If your solid 
white object is a note expression, you can choose whether you’d like it to cover up everything, 
or the notes, or just the staff lines (leaving notes, lyrics, and other musical material in front of 
the mask, so that they’re still visible).

The technique: if you want to cover up everything, attach the expression to a subsequent note. 
In the following illustration, you can see the difference.

At left, the Expression was attached to the first eighth note, as indicated by the arrow. As a result, 
the shape only covers up the staff lines. If the shape is attached to a following note (right), the mask 
covers everything.

If your shape is a measure expression, however, the white rectangle will always cover only the 
staff; the notes still appear.

To move, reshape, or delete a Shape Expression mask

• Click the Expression Tool y, and click the note or measure to which the shape was 

attached. Its handles appear.

• Drag the handle to move the entire shape. Click the handle and press delete to remove it. 
To stretch the shape, double-click a handle; its bounding handles appear, which you can drag 
to make the rectangle larger or smaller.

To mask a portion of the score using the Graphics Tool
You can also create a white mask using the Graphics Tool. While the procedure is much easier 
with the Graphics Tool, one potential downside is that it involves the creating of a graphic file, 
separate from Finale, which you must remember to include should you transport your Finale file 
to print elsewhere. Also, the Graphics Tool method works like a measure expression in that it will 
always cover anything you place it on top of.

• Select the Graphics Tool e and select Page View from the File Menu. 

• In a blank area of the page, double-click and drag the mouse down and to the right, cre-
ating a square or rectangle approximately the size of the area you wish to mask. Since 
you’re going to paste this box on top of unwanted items in your file, be advised that anything 
that appears within the lines of the box will appear in your score. So, if you inadvertently drew 
the box on top of something, try it again.

• Choose Export Selection from the Graphics Menu. 

• Click OK. 
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• Type in the name you would like to call your file in the dialog box that appears. 

• Choose Place Graphic from the Graphics Menu. 

• Select the file you just created. Note that the cursor changes to a box with and X inside.

• Place the cursor in the upper left hand corner of where you’d like the white mask to 
appear, and then click the mouse. Note that the white mask now has eight handles on it. If 
you need to fine tune its position, you can do so by dragging these handles.

Keep in mind that in addition to pasting in blank material you can use this same procedure to 
copy and paste musical examples–incipits for example. See GRAPHICS TOOL for more infor-
mation.

To move, reshape or delete a Graphics Tool mask

• Select the Graphics Tool e and select Page View from the File Menu. 

• Click on the mask. If you wish to move the entire mask, click on it and drag while keeping 
the mouse button pressed; to reshape the mask simply drag the handles accordingly. Press 
backspace to delete the mask.
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